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Section 1 
Overview of project 

 
 

A. Where we have uploaded our tutorial 
 
https://www.instructables.com/id/Smart-Garage 
 

B. Why have we chosen to upload to this site 
 
We choose instructables because it is user friendly. We can use features such as adding in cards or 

files. This allows customisation of sharing what we have learnt to the people. 
 
 

C. What have we uploaded 
 
Overview, hardware requirements, setting up the application.  
 

D. What is the application about? 
 
The Smart Garage is a IOT solution which, when the owners drive the cars into the garage, the motion 
sensor is activated to enable the door to open. The cars will also have a lcd display installed to show 
them the state of the sensors. When the car is reversing, the obstacle avoidance sensor that is 
mounted on the car will be activated to sense for objects. This will ensure safety, as there might be 
people in the garage. Next, the distance sensor is activated to check how much distance is left to stop 
parking. Some people might be thinking of some important matters which divert their attention and 
causes them to lose control.  The lcd display will display message to stop parking when there are no 
more distances left.  If the owner has drived the car into the wall, the shock sensor is activated to 
notify the user that the car has hit the wall.  
 
To ensure security, the nfc card reader is mounted onto the entrance. The owners can use the nfc 
card to tap on the reader to be allowed access. If the card tapped is correct, the green light will be 
on. The authorised owners can switch on/off the light in the garage. Otherwise, the red light will be 
on and the alarm will go off. An email notification will be sent to the owners’ inbox.  Moreover, SMS 
will be sent to the owners’ handphones. 
 
The garage also has a bin that has a weight sensor attached to it. It can detect how much weight the 
rubbish are in the bin. This will ensure the owners to empty the bin when they see the data sent by 
the weight sensor in the web portal.  
 
The web application has a login feature which only authorised users are allowed. The authorised 
users can view live streaming in the garage. In addition, the users can control the light in the garage 
remotely. They can view the security access records and a pie chart that shows the percentage of the 

https://www.instructables.com/id/Smart-Garage
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shock status produced by the car that has hit the wall. Moreover, the weight of the rubbish in the bin 
is the data displayed in the form of table and line chart. The user can also click on image recognition 
to be navigated to another web portal/ 

 
 

E. Summary of the steps that will be described 
 
Provide a bullet list of the steps that will be covered in the other parts of this tutorial 

 
 Section Description 
1)  Overview An idea of Smart Garage and public tutorial. 

   
Sections 2 to 8 provides the step-by-step instructions to set up the application 
2)  Hardware requirements Provides overview of hardware required 
3)  AWS Steps are provided to show how to set up the environment in 

AWS.  
4)  RPi – Connecting the 

components 
Steps are provided to show how components (sensors and 
actuators) can be connected on the RPi breadboard. 

5)  RPi – Codes to enable 
components run 

Codes are provided to enable RPi sensors and actuators to run. 

6)  Arduino – Connecting 
the components 

Steps are provided to show how components (sensors and 
actuators) can be connected on the Arduino breadboard. 

7)  Arduino – Codes to 
enable components run 

Codes are provided to enable Arduino sensors and actuators to 
run. 

8)  Web Application – Codes 
to set up web application 

Codes are provided to enable web application to display data 
and enable users to perform operations. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

F. How does the final RPI set-up looks like? 
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G. How does the web or mobile application look 
like? 
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Section 2 
Hardware requirements  

 

Hardware checklist 
 
 

RaspberryPi  
 

Hardware  Quantity Check 
RaspberryPi with NoIR Camera Board, MicroSD Card and Casing 3  
3-pin Power Adaptor 3  
T-Cobbler set with Breadboard, MCP3008 ADC, Ribbon Cable  3  
NFC Card Reader 1  
NFC Card 3  
Male-Female Jumper Wires 14  
Male-Male Jumper Wires 25  
LEDs 3  
330 ohms Resistors 3  
Buzzer 1  
Button 1  
10000 ohms Resistor 1  

 
Arduino 

 
Hardware  Quantity Check 
UNO R3  2  
USB B Cable 2  
Breadboard 2  
Male-Female Jumper Wires 20  
Male-Male Jumper Wires 15  
12C LCD Display 1  
Pir Motion Sensor  1  
HC-SR04 Ultrasonic Sensor 1  
FC-51 Obstacle Avoidance Sensor  1  
KY-002 Vibration Switch Sensor 1  
Load Cell (Weight Sensor) 1  



 ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

 

  
  

HARDWARE 

 The Raspberry Pi is a low cost, credit-card sized 
computer that plugs into a computer monitor 
or TV, and uses a standard keyboard and 
mouse. It is a capable little device that enables 
people of all ages to explore computing, and to 
learn how to program in languages like Scratch 
and Python. 

 Power adapter is used to power raspberry pi. 

 This is the t-cobbler kit mounted on breadboard 
with ribbon cable attached to t-cobbler so that they 
can communicate with raspberrypi. Sensors, 
actuators and jumper wires are used to plug into 
the breadboard. 
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           NFC Card Reader allows users to tap card.  
 
 
   

Male to male jumper wires allows users to connect  
components on breadboard. 
 
 
 
 
 
 
 
 
Male to female jumper wires allows users to 
connect components on breadboard. 
 

LED can light up! 
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Resistors limit the current to the actuators, preventing 
raspberrypi from burning out. 

Buzzer will produce sound. This has useful applications such as 
security. 

Button is used to control led, such as by pushing 
down the button, the light will be switch on. 

Arduino UNO R3 is an open-source electronics platform based on easy-to-use hardware and 
software. Arduino boards are able to read inputs - light on a sensor, a finger on a button, or a 
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Twitter message - and turn it into an output - 
activating a motor, turning on an LED, publishing 
something online 

This is the USB B cable. It is able to connect to arduino and 
raspberrypi. 

This LCD display is used to display messages. 
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This is the pir motion sensor which can detect 
motion. 

Ultrasonic sensors measure distance by 
using ultrasonic waves. The sensor head 
emits and ultrasonic wave and receives 
the wave reflected back from the target. 
Ultrasonic sensors measure the distance 
to the target by measuring the time 
between the emission and reception. 

FC-51 obstacle avoidance sensor is used to 
detect for obstacles. It will light up only when it 
detects obstacles. 
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The vibration switch sensor can sense the severity of 
the shock that it has received. 

A load cell is a transducer that is used to measure weight.  
There are different load cells that support different weight (1kg, 
5kg, 10kg, 40kg, etc) 
Works hand in hand with the HX711. 

 

Section 3 
AWS 

 

  
  

PREPARATIONS 

Ensure that you already have a AWS account. AWS is required for this project. If you do not 
have an account, please visit aws website to sign up for an account. 
 
Please sign in to the aws console. 

 

https://aws.amazon.com/free/
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Configuration for IoT Core in AWS console  

 Once you are signed in, you are ready to work on it. 

1.  Click on Services.  
Enter IoT Core > Click on the IoT Core to be navigated. 
 

 

2.  Click on Manage > Things 

 

3.  Click on Create button. 
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4.  Click on Create a single thing button. 

 

5.  Enter the information as shown in the picture. Leave others as default. 
Name: GarageParking 
 

 

6.  Click on Next button. 
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7.  Click on Create certificate button. 
 

 

8.  Click on the buttons that are circled. 
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9.  Now you redirected to aws site. Click on the RSA 2048 bit key: VeriSign Class 3 Public 
Primary G5 root CA certificate. 

 

10.  You will be redirected to a page that has content of a certificate. Copy it all and paste it in 
the notepad. Save it in a folder that shares with the previously downloaded 3 certificates 
in step 8. 
 
Save the file as rootca.pem. 
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11.  Rename the other 3 files as shown in the picture. 
 

 

12.  Return back to the certificates download page and click on the Activate button. 
 
 

 

13.  Notification appears upon successful activation.  
 

 

14.  Click on Done button. 
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15.  GarageParking thing appears. 
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16.  Click on Secure > Certificates.   
 

17.  Hover over the certificate that you have created.  
Click on the checkbox > Actions > Activate. 

 

18.  Successful notification appears upon activation. 
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19.  Click on Secure > Policies 
 

20.  Click on Create button. 
 

 

21.  Enter the information as shown in the picture.  
Name: GarageParkingPolicy 
Action: iot:* 
Resource ARN: * 
Effect: Allow 
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22.  Click on Create button. 

 

23.  Successful notification apperas upon policy creation. The created policy appears. 
 

 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 15 of 125  
 

  
  

24.  Go to Secure > Certificates.  

25.  Click on the horizontal ellipsis of the certificate that you have created. 
 
Click on Attach policy button. 
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26.  Click on the checkbox beside the policy that has been created just now. 
Click on Attach button. 
 

 

27.  Successful notification appears upon attachment of policy. 
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28.  Click on the horizontal ellipsis of the certificate that you have created. 
 
Click on Attach thing button. 
 

 

29.  Click on the checkbox beside the thing that has been created just now. 
Click on Attach button. 
 

 

30.  Successful notification appears upon attachment of thing. 
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31.  Click on Manage > Things. 
Click on GarageParking. 

 

32.  Click on Interact. 
Copy down the rest api end point and paste it in a notepad. Your endpoint will be different 
from mine. 
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Create Dynamo Tables 

33.  Click on Services > DynamoDB.  
 

 
 

34.  Click on Tables > Create table 

 
 

35.  Enter the information as shown in the picture. 
Table name: PhysicalAccess, Primary key: PAId (String) 
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36.  Click on Create button. 
 

 

37.  The created table is shown. 

 

38.  Click on Create Item button. 
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39.  Click on the + button beside PAId. 
Click on Insert > String. 

 

40.  Enter IntrusionDetected as the field. 
 

 

41.  Repeat step 39. 
Enter TimeStamp as the field. 

 

42.  Enter the values as shown in the picture. 
TimeStamp: 2018-08-15, IntrusionDetected: False, PAId: 1.  
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43.  Click on Save button. 

 

44.  The record appears in the table. By doing this, it will allow the records to be inserted 
properly as the table has the columns. 
 

 

45.  Click on Tables > Create table 

 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 23 of 125  
 

  
  

46.  Enter the information as shown in the picture. 
Table name: Shock, Primary key: Shock_Id (String) 

 

47.  Click on Create button. 

 

48.  The created table is shown. 

 

49.  Click on Create item button. 
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50.  Click on the + button beside PAId. 
Click on Insert > String. 
 

 

51.  Enter Status as the field. 
 

 

52.  Repeat step 51. 
Enter TimeStamp as the field. 

 

53.  Enter the values as shown in the picture. 
TimeStamp: 2018-02-12, Status: absent, Shock_Id: 1.  
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54.  Click on Save button. 
 

 

55.  The record appears in the table. By doing this, it will allow the records to be inserted 
properly as the table has the columns. 
 

 

56.  Now, we will create the weight table now. 
Enter the information as shown in the picture 
Table Name: WeightDb, Primary Key: recordedAt(String),  



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 26 of 125  
 

  
  

 

57.  Click on Create button. 
 

 
The created table is shown. 

 

58.  Now, we will be creating the user table. 
Enter the information as shown in the picture. 
Table name: User, Primary key: User_Id (String) 
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59.  Click on Create button. 

 

60.  The created table is shown. 

 

61.  Create the columns shown in the picture as explained in the first 2 tables.  
You are free to enter the values for the fields that are blank. You can create more than 1 
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user. 

 

62.  Click on Save button. 
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63.  The records appear. 

 
We will proceed to create rules now! 

 

  
  

Create Rules in IoT Core 

64.  Click on Services > IoT Core.  
Enter IoT Core > Click on the IoT Core to be navigated. 
 

 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 30 of 125  
 

  
  

65.  Click on Act. 
 

66.  Click on Create button. 

 

67.  Enter the information as shown in the picture. 
Name: PhysicalAccess, 
Description: This rule is used to insert unauthorised or authorised entries, timestamps into 
the database. 
SQL version: 2016-03-23 
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68.  Enter the information as shown in the picture. 
Attribute: * 
Topic filter: GarageParking/1/PhysicalAccess 
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69.  Click on the button circled.  

 

70.  Click on the radio button as shown in the picture. 

 

71.  Click on Configure action button. 
 

 

72.  Select PhysicalAccess from the drop down list for table name. 
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73.  Click on Create a new role button. 

 

74.  Enter the information as shown in the picture. 
IAM role name: PhysicalAccessRole 
Click on Create a new role button. 

 

75.  Choose PhysicalAccessRole from the drop down list. 
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76.  Click on Add action button. 
 

 

77.  Click on Create rule button. 

 

78.  Successful notification appears upon creation of PhysicalAccess rule. The rule appears.  
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79.  We will be creating the shock rule. 
Click on Create button. 
 

 

80.  Enter the information as shown in the picture. 
Name: Shock, 
Description: This rule is used to capture shock data if the driver has accidentally driven his 
car against the wall. 
SQL version: 2016-03-23 

 

81.  Enter the information as shown in the picture. 
Attribute: * 
Topic filter: GarageParking/1/ShockData 
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82.  Click on the button circled. 

 

83.  Click on the radio button as shown in the picture. 
 

 

84.  Click on the Configure action button. 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 37 of 125  
 

  
  

 

85.  Select Shock from the drop down list for table name. 
 

 

86.  Click on Create a new role button. 
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87.  Enter the information as shown in the picture. 
IAM role name: ShockRole 
Click on Create a new role button. 

 

88.  Choose ShockRole from the drop down list. 

 

89.  Click on Add action button. 

 

90.  Click on Create rule button. 
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91.  Successful notification appears upon creation of PhysicalAccess rule. The rule appears. 

 

92.  We will be creating the weight rule. 
Click on Create button. 
 
 

 
 
 

93.  Enter the information as shown in the picture. 
Name: weightValueToDb 
Description: Sends a weight value to the database 
SQL version: 2016-03-23 
Attribute: * 
Topic filter: sensors/weight 
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94.  Click on Add Action button. 

 

95.  Select Split message into multiple columns of a database table(DynamoDBv2) 
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96.  Enter the information as shown in the picture 
Table name: WeightDb 
IAM role name: WeightRole 

 

97.  Click on Add action 
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98.  Click on Create Rule 

 

99.  The rule is created successfully.  
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Section 4 
RPi – Connecting the components 

 
Section 5 contains setting up garage parking and face recognition on each rpi respectively. The third 
rpi does not require any setup of sensors/actuators as it is used for connecting to arduino which has 
load cell (weight sensor). 
You are free to use any colours of jumper wires. There are no restrictions. Coloured jumper wires 
helps you to differentiate which hole you are connecting to. Do not panic if you don’t have the 
coloured jumper wires mentioned. You can always use another jumper wire. Excited to get your 
hands dirty? We will do it now! 
 

  
  

Garage Parking 

CONNECT 3V3 & GND TO POSITIVE AND NEGATIVE RAILS 
RESPECTIVELY 

1.  Plug one end of blue male-male jumper wire to the hole that corresponds to 3V3. Plug the 
other end to the positive rail. The positive rail has a positive sign and has a red colour line. 

2.  Plug one end of black male-male jumper wire to the hole that corresponds to GND. Plug 
the other end to the negative rail. The negative rail has a negative sign and has a blue 
colour line. 

Explanation 
We might not have enough 3V3 or GND holes that corresponds to the t-cobbler. By doing this, 
we can plug more jumper wires to the negative and postive rails that has GND and 3V3 power 
respectively! 

CONNECT RED LED & RESISTOR 

3.  Plug the red led on the breadboard as shown.  

4.  Plug in the 330 Ω resistor into the breadboard as shown. One end of the resistor should be 
in the same column as the long leg of the LED.  

5.  Plug one end of  male-male jumper wire to the column that corresponds to the       
shorter leg of the led. 
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6.  Plug the other end of  male-male jumper wire to the hole in the negative rail. 

7.  Plug one end of brown male-male jumper wire into the same column of the other end of 
resistor. Note that the other end of the resistor is already connected to the long leg of LED 
in step 4. 

8.  Plug the other end of brown male-male jumper wire to hole that corresponds to GPIO18 
on the t-cobbler. We have finished the setup for the red led and resistor. Next, we will be 
repeating the same process for the other green led. 

CONNECT GREEN LED & RESISTOR 

9.  Plug the green led on the breadboard as shown.  

10.  Plug in the 330 Ω resistor into the breadboard as shown. One end of the resistor should be 
in the same column as the long leg of the LED.  

11.  Plug one end of grey male-male jumper wire to the column that corresponds to the       
shorter leg of the led. 

12.  Plug the other end of grey male-male jumper wire to the hole in the negative rail. 

13.  Plug one end of green male-male jumper wire into the same column of the other end of 
resistor. Note that the other end of the resistor is already connected to the long leg of LED 
in step 10. 

14.  Plug the other end of green male-male jumper wire to hole that corresponds to GPIO6 on 
the t-cobbler. We have finished the setup for the green led and resistor. Next, we will 
connect yellow LED and resistor. 

CONNECT YELLOW LED & RESISTOR 

15.  Plug the yellow led on the breadboard as shown.  

16.  Plug in the 330 Ω resistor into the breadboard as shown. One end of the resistor should be 
in the same column as the long leg of the LED.  

17.  Plug one end of light brown male-male jumper wire to the column that corresponds to the       
shorter leg of the led. 
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18.  Plug the other end of light brown male-male jumper wire to the hole in the negative rail. 

19.  Plug one end of purple male-male jumper wire into the same column of the other end of 
resistor. Note that the other end of the resistor is already connected to the long leg of LED 
in step 16. 

20.  Plug the other end of purple male-male jumper wire to hole that corresponds to GPIO21 
on the t-cobbler. We have finished the setup for the yellow led and resistor. Next, we will 
connect the button to switch the yellow led on/off. 

CONNECT BUTTON 

21.  Plug the button into the breadboard as shown.  

22.  Plug in the 10000 Ω resistor into the breadboard as shown. One end of the resistor should 
be in the same column as the first leg of the button. 

23.  Plug one end of violet male-male jumper wire into the same column of the other leg of 
button. Note that the other leg of the button is already in the same column as one leg of 
the resistor in step 22. 

24.  Plug the other end of violet male-male jumper wire to the positive rail. 

25.  Plug one end of black male-male jumper wire into the same column of the first leg of 
resistor.  

26.  Plug the other end of black male-male jumper wire to the negative rail. 

27.  Plug one end of brown male-male jumper wire into the same column of the second leg of 
resistor. Note that the first leg of the resistor is in the same column as the black male-
male jumper wire in step 25. 

28.  Plug the other end of brown male-male jumper wire to hole that corresponds to GPIO13 
on the t-cobbler. We have finished the setup for the button. Next, we will connect the 
buzzer. 

CONNECT BUZZER 

29.  Plug the buzzer into the breadboard as shown. 
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30.  Plug one end of  male-male jumper wire into the same column as the first leg of 
buzzer. 

31.  Plug the other end of  male-male jumper wire to the hole that corresponds to GPIO5 
on the t-cobbler. 

32.  Plug one end of green male-male jumper wire into the same column as the second leg of 
buzzer. Note that the first leg of the buzzer is already in the same column as one end of 
the  male-male jumper wire. 

33.  Plug the other end of green male-male jumper wire to the negative rail. We have finished 
the setup for the buzzer. Next, we will connect the nfc card reader. 

CONNECT NFC CARD READER 

34.  There are about 9 pins on the MFRCF522 reader (NFC card reader). 
 
We will only be using 7 of them. 
 
Connect the pins on the MFRCF522 card reader to the RPi as indicated below. 
The jumper wires used are a male-female. 
 

Jumper color MFRCF522pin RPi pin 
Yellow SDA CE0 
Orange SCK SCLK 
Brown MOSI MOSI 
Dark Pink MISO MISO 
 IDR  
Black GND GND 
White RST GPIO25 
Red 3.3V 3.3V 
 5V  

 

CONNECT PI CAMERA 
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 35. Connect your camera module to the 
CSI port on your Raspberry Pi; this is 
the long thin port adjacent to the 
HDMI socket. 

36. Gently lift the collar on top of the 
CSI port and slide the ribbon cable of 
the camera module into the port 
with the blue side facing the 
Ethernet port 

37. Once the cable is seated in the port, 
press the collar back down to lock the cable in place. 

The picture shows a well-seated camera cable with the correct orientation. 
 
We have completed the setup for connecting the components! Now, we will move on to 
setting up face recognition on another rpi! 

 
 
 

Section 5 
RPi – Codes to enable components run 

  
  

PREPARATIONS 

Before we start creating files that are needed to run the rpi components, we have to create 
folders. So that, our files are organised neatly. 
 
Typing this command in the command line will create a new folder in the root directory.  
 
mkdir Garage_Parking 

You will see a folder created in the directory.  
To be in the folder, 
Type  
cd Garage_Parking 
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Now, we will create a new folder to contain the files that are needed to run rpi components! 
 
mkdir rpi_components 

We have to set up the virtualenv. Firstly install virtualenv via pip. 
pip install virtualenv  

create a directory called virtualenv and move into it 
mkdir virtualenv 
cd virtualenv 

Now to activate virtualenv type: 
Virtualenv virtualenv 

A bin folder will be created, move into it and type this command to activate virtualenv: 
cd /bin 
source activate 

There you should see (virtualenv) beside your path, and virtualenv is activated! 
 
cd ..  

 
Type this command again. 
cd ..  

 
Create a file called requirements.txt and copy paste this in: 
awscli==1.15.80 
AWSIoTPythonSDK==1.4.0 
boto3==1.7.79 
botocore==1.10.79 
certifi==2018.8.13 
chardet==3.0.4 
click==6.7 
cognitive-face==1.4.2 
colorama==0.3.9 
docutils==0.14 
Flask==1.0.2 
Flask-Login==0.4.1 
futures==3.2.0 
idna==2.7 
itsdangerous==0.24 
Jinja2==2.10 
jmespath==0.9.3 
MarkupSafe==1.0 
picamera==1.13 
pyasn1==0.4.4 
python-dateutil==2.7.3 
PyYAML==3.13 
requests==2.19.1 
RPi.GPIO==0.6.3 
rsa==3.4.2 
s3transfer==0.1.13 
six==1.11.0 
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urllib3==1.23 
Werkzeug==0.14.1 

 
This contains the required packages. This acts like a package.json in your flask application. 
To generate and update new packages you’be installed in this virtual environment type: 
pip freeze > requirements.txt 

Note that the host mentioned earlier, is on your notepad. You can copy this and paste it into the 
host. 
Create a file called aws_connection.py and copy paste this in: 
# Import SDK packages 
from AWSIoTPythonSDK.MQTTLib import AWSIoTMQTTClient 
from time import sleep 
 
def connectToAWS():  
    try: 
        host = "xxxx" 
        rootCAPath = "/home/pi/GarageParking/device_certs/rootca.pem" 
        certificatePath = "/home/pi/GarageParking/device_certs/certificate.pem.crt" 
        privateKeyPath = "/home/pi/ GarageParking/device_certs/private.pem.key" 
 
        garage_parking = AWSIoTMQTTClient("GarageParking") 
        garage_parking.configureEndpoint(host, 8883) 
        garage_parking.configureCredentials(rootCAPath, privateKeyPath, certificatePath) 
    
        garage_parking.configureOfflinePublishQueueing(-1)  # Infinite offline Publish queueing 
 
        garage_parking.configureDrainingFrequency(2)  # Draining: 2 Hz 
        garage_parking.configureConnectDisconnectTimeout(10)  # 10 sec 
        garage_parking.configureMQTTOperationTimeout(5)  # 5 sec 
 
        # Connect to AWS IoT 
        garage_parking.connect() 
        return garage_parking 
    except(ValueError): 
        print(ValueError); 

We have to configure the aws.  
Type  
aws configure  
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You will see that you have to enter your access key, secret key, region as according to the 
configuration to your aws account. 
It will look something like this 
 

 

We need to create another file which is pubsubWeight.py 
 
Paste the code into the file  
 
# Import SDK packages 
from AWSIoTPythonSDK.MQTTLib import AWSIoTMQTTClient 
import serial 
from time import sleep 
from datetime import datetime 
import aws_connection 
 
arduino = serial.Serial("/dev/ttyUSB0",9600) 
 
# Custom MQTT message callback 
def customCallback(client, userdata, message): 
 print("Received a new message: ") 
 print(message.payload) 
 print("from topic: ") 
 print(message.topic) 
 print("--------------\n\n") 
 
my_rpi = aws_connection.connectToAWS() 
 
def subscribeToTopic(): 
        # Connect and subscribe to AWS IoT topic "sensors/weight" 
        my_rpi.subscribe("sensors/weight", 1, customCallback) 
        sleep(2) 
 
# Publish to the same topic in a loop  
def publishToTopic(): 
        while True: 
                weight = arduino.readline() 
                jsonString = "{\"weight\" : " + str(weight) + ", 
\"recordedAt\": \"" + datetime.now().strftime('%Y-%m-%d %H:%M:%S') + "\"}" 
                my_rpi.publish("sensors/weight", jsonString, 1) 
 
                sleep(5) 
 
subscribeToTopic() 
publishToTopic() 
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Press ctrl+o first and hit the enter key on the keyboard. The file is saved now. Hit ctrl+z to exit 
the file. 

You can upload the 4 files which are the certificates needed to have the mqtt client connect to 
AWS through filezilla in section 3, step 10-11. 
 
Put these 4 files in device_certs folder in Garage_Parking. You would have to manually create a 
folder in Garage_Parking. 

We need to enable camera with raspi-config 
 
Open the Raspberry Pi Configuration Tool from the 
main menu:  

Ensure the camera software is enabled. If it's 
not enabled, enable it and reboot your Pi to 
begin. 
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MFRC522 CARD READER 

 If you are working on a fresh Raspbian install, there are some things you would need to 
prepare before the code given in the next section can work. 

1.  We have to enable SPI via raspi-config. 
Run raspi-config, choose menu item “5 Interfacing Options” and enable SPI. 
 
sudo rasp-config 

 
 

          
 
 

2. v
 

We have to enable device tree in boot.txt. We have to jump back to the root. To jump 
back, we have to run the command two times. 
cd .. 

Modify the /boot/config.txt to enable SPI 
sudo nano /boot/config.txt 

3.  Ensure these lines are included in config.txt 
device_tree_param=spi=on 
dtoverlay=spi-bcm2835 

4.  Install the Python development libraries 
sudo apt-get install python-dev 

5.  Set up the SPI Python libraries since the card reader uses the SPI interface 
git clone https://github.com/lthiery/SPI-Py.git 
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cd /home/pi/SPI-Py 
sudo python setup.py install 

6.  Clone the MFRC522-python library and copy out  the required files to the project directory 
 
git clone https://github.com/mxgxw/MFRC522-python 
cd MFRC522-python 
sudo cp *.py ~/Garage_Parking/rpi_components 

CODE THE PROGRAM 

 Now that, we have setup the environment for the MFRC522. We are ready to code now! 

7.  To jump to the rpi_components folder, type 
 
cd Garage_Parking/rpi_components 

8.  To create a file, type 
 
sudo nano NFC_Security.py  

 
Now, we will proceed to paste the code. 
Please note that in the sendMail() method, you have to add in your own email addresses. 
Password has to be added in the login method. 
import RPi.GPIO as GPIO 
import MFRC522 
import signal 
import datetime 
import os,sys 
import GP_Lights 
import smtplib 
from email.MIMEMultipart import MIMEMultipart 
from email.MIMEText import MIMEText 
from signal import pause 
from boto3.dynamodb.conditions import Attr 
import boto3 
import uuid 
 
current_directory = os.getcwd() 
parent_directory = os.path.dirname(current_directory) 
sys.path.insert(0, parent_directory) 
 
import aws_connection 
import database 
 
# connect to aws 
garageParking = aws_connection.connectToAWS() 
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def sendMail(): 
    fromaddr = "XXXX" 
    toaddr = "XXXX" 
    msg = MIMEMultipart() 
    msg['From'] = fromaddr 
    msg['To'] = toaddr 
    msg['Subject'] = "Garage: Unauthorised Access" 
  
    body = "There is an attempt of unauthorised access to your garage." 
    msg.attach(MIMEText(body, 'plain')) 
  
    server = smtplib.SMTP('smtp.gmail.com', 587) 
    server.starttls() 
    server.login(fromaddr, "your email pw") 
    text = msg.as_string() 
    server.sendmail(fromaddr, toaddr, text) 
    server.quit() 
 
 
# NFC 
uid = None 
continue_reading = True 
 
def end_read(signal, frame): 
    global continue_reading 
    print("Ctrl+C captured, ending read.") 
    continue_reading = False 
    GPIO.cleanup() 
 
# Hook the SIGINT 
signal.signal(signal.SIGINT, end_read) 
 
# Create an object of the class MFRC522 
mfrc522 = MFRC522.MFRC522() 
 
# Get Resource 
dynamoDb = database.getResource() 
 
# Scan for cards 
 
 
try: 
    while continue_reading: 
        (status, TagType) = mfrc522.MFRC522_Request(mfrc522.PICC_REQIDL) 
        # If a card is found 
         
        if status == mfrc522.MI_OK: 
        # Get the UID of the card 
            (status, uid) = mfrc522.MFRC522_Anticoll() 
 
            currentDT = datetime.datetime.now() 
            userTable = dynamoDb.Table('User') 
            response = 
userTable.scan(FilterExpression=Attr('NFC_Uid').eq(str(uid))) 
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            records = response['Items'] 
            light = GP_Lights.Light() 
            newId = uuid.uuid4() 
            if(len(records) > 0): 
                intrusion_suspected = False 
                mqtt_message = "{\"PAId\":\"" + str(newId) + 
"\",\"IntrusionDetected\":\"" + str(intrusion_suspected) + "\" 
,\"TimeStamp\":\"" + str(currentDT) + "\"}" 
                garageParking.publish("GarageParking/1/PhysicalAccess", 
mqtt_message, 1) 
                light.authorised() 
                light.onLight() 
                continue_reading = False; 
            else:  
                light.unauthorised() 
                sendMail() 
                response = userTable.scan() 
                records = response['Items'] 
                sns = boto3.client('sns') 
                for record in records: 
                    hp_no = record['Hp_No'] 
                    try: 
                        number = str(hp_no) 
                        sns.publish(PhoneNumber = number, Message='There 
is an unauthorised access to the garage' ) 
                    except ValueError: 
                        print(ValueError) 
                intrusion_suspected = True 
                mqtt_message = "{\"PAId\":\"" + str(newId) + 
"\",\"IntrusionDetected\":\"" + str(intrusion_suspected) + "\" 
,\"TimeStamp\":\"" + str(currentDT) + "\"}" 
                garageParking.publish("GarageParking/1/PhysicalAccess", 
mqtt_message, 1) 
                continue_reading = False; 
            pause() 
except KeyboardInterrupt: 
    pass 
finally: 
    GPIO.cleanup() 

Press ctrl+o first and hit the enter key on the keyboard. The file is saved now. Hit ctrl+z to 
exit the file. 

9.  Unfortunately, we are still not ready to run the file yet. We have to create another file 
which contains code to power the leds.  
 
Run 
sudo nano GP_Lights.py  
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10.  Paste the code into the file. 
 
import RPi.GPIO as GPIO  
from time import sleep 
from signal import pause 
 
class Light: 
     
    GPIO.setmode(GPIO.BOARD) 
 
    def unauthorised(self): 
        redLed = 12  
        bz = 29   
        GPIO.setup(redLed,GPIO.OUT) # Red LED lights up when the user is 
not authorised 
        GPIO.setup(bz,GPIO.OUT) # Buzzer sounds together with red LED 
when the user is not authorised 
        GPIO.output(redLed,True) 
        GPIO.output(bz, GPIO.HIGH) 
        sleep(8) 
        GPIO.output(redLed, False) 
        GPIO.output(bz, GPIO.LOW) 
        GPIO.cleanup() 
 
    def authorised(self): 
        greenLed = 31  # Green LED lights up when the user is authorised 
        GPIO.setup(greenLed,GPIO.OUT) 
        GPIO.output(greenLed,True) 
        sleep(5) 
        GPIO.output(greenLed, False) 
        GPIO.cleanup() 
     
     
    def onLight(self): 
        GPIO.setmode(GPIO.BOARD) 
        button1 = 33 
        garageLed = 40 
        BS=False 
        GPIO.setup(button1,GPIO.IN) 
        GPIO.setup(garageLed,GPIO.OUT) 
        while(1):                  # Create an infinite Loop 
            if GPIO.input(button1):            # Look for button press 
                if BS==False:                # If the LED is off 
                    GPIO.output(garageLed,True)# turn it on 
                    print("Light is on") 
                    BS=True              # Set Flag to show led is now On  
                    sleep(.5)             # Delay 
                else:                         # If the LED is on 
                    GPIO.output(garageLed,False) # Turn LED off 
                    print("Light is off") 
                    BS=False               # Set Flag to show led is now 
Off 
                    sleep(.5) 
        GPIO.cleanup() 
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    def remoteOnLight(self): 
        garageLed = 40 
        GPIO.setup(garageLed,GPIO.OUT) 
        GPIO.output(garageLed,True) 
        sleep(5) 
 
    def remoteOffLight(self): 
        garageLed = 40 
        GPIO.setup(garageLed,GPIO.OUT) 
        GPIO.output(garageLed,False) 
        sleep(5) 
 

 
Press ctrl+o first and hit the enter key on the keyboard. The file is saved now. 
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11.  We will have to create another file which is weight.py. 
Run 
sudo nano weight.py  
 
Paste the code into the file 
 
import itertools 
import json 
import boto3 
import decimal 
 
# Helper class to convert a DynamoDB item to JSON. 
class DecimalEncoder(json.JSONEncoder): 
    def default(self, o): 
        if isinstance(o, decimal.Decimal): 
            if o % 1 > 0: 
                return float(o) 
            else: 
                return int(o) 
        return super(DecimalEncoder, self).default(o) 
 
dynamodb = boto3.resource('dynamodb', region_name='ap-southeast-1', 
endpoint_url="http://dynamodb.ap-southeast-1.amazonaws.com") 
 
table = dynamodb.Table('WeightDb') 
pe = "weight, recordedAt" 
 
def retrieveData(): 
    response = table.scan( 
        ProjectionExpression=pe, 
    ) 
 
    data = [] 
 
    for i in response['Items']: 
        d = [] 
        recordedAt, weight = i["recordedAt"], i["weight"] 
        d.append(recordedAt) 
        d.append(weight) 
        data.append(d) 
 
    while 'LastEvaluatedKey' in response: 
        response = table.scan( 
            ProjectionExpression=pe, 
            ExclusiveStartKey=response['LastEvaluatedKey'] 
        ) 
 
        for i in response['Items']: 
            d = [] 
            recordedAt, weight = i["recordedAt"], i["weight"] 
            d.append(recordedAt) 
            d.append(weight) 
            data.append(d) 
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    return data 

 
Press ctrl+o first and hit the enter key on the keyboard. The file is saved now. 
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12.   

13.  Before we proceed to run NFC_Security.py. We have to create a __init__.py file. So that 
the system can recognise this folder as a package and we can import files in this directory 
from another directory. Note that it is a double underscore not one. 
 
Run 
sudo nano __init__.py 

 
There is no need for you to type anything in this file. 
Press ctrl+o first and hit the enter key on the keyboard. The file is saved now. 

14.  Finally, we can run the file now! 
Run 
python NFC_Security.py 

15.  You can use the card to tap on the NFC card reader. If authorised, the green led will light 
up. Assuming that you are in the garage, you can press the button to on the yellow led and 
press again to off the yellow led. If you are not authorised, the red led will light up and the 
buzzer will sound.  
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16.  We still have to create models for the pi camera so that we can view live streaming of the 
garage in the web portal.  
 
We have to jump out of the directory now.  
 
Run 
cd .. 

 
To create a new folder 
 
Run 
mkdir models  

17.  Run 
sudo nano base_camera.py 

 
Paste the code into the file. 
 
import time 
import threading 
try: 
    from greenlet import getcurrent as get_ident 
except ImportError: 
    try: 
        from thread import get_ident 
    except ImportError: 
        from _thread import get_ident 
 
 
class CameraEvent(object): 
    """An Event-like class that signals all active clients when a new 
frame is 
    available. 
    """ 
    def __init__(self): 
        self.events = {} 
 
    def wait(self): 
        """Invoked from each client's thread to wait for the next 
frame.""" 
        ident = get_ident() 
        if ident not in self.events: 
            # this is a new client 
            # add an entry for it in the self.events dict 
            # each entry has two elements, a threading.Event() and a 
timestamp 
            self.events[ident] = [threading.Event(), time.time()] 
        return self.events[ident][0].wait() 
 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 62 of 125  
 

  
  

    def set(self): 
        """Invoked by the camera thread when a new frame is available.""" 
        now = time.time() 
        remove = None 
        for ident, event in self.events.items(): 
            if not event[0].isSet(): 
                # if this client's event is not set, then set it 
                # also update the last set timestamp to now 
                event[0].set() 
                event[1] = now 
            else: 
                # if the client's event is already set, it means the 
client 
                # did not process a previous frame 
                # if the event stays set for more than 5 seconds, then 
assume 
                # the client is gone and remove it 
                if now - event[1] > 5: 
                    remove = ident 
        if remove: 
            del self.events[remove] 
 
    def clear(self): 
        """Invoked from each client's thread after a frame was 
processed.""" 
        self.events[get_ident()][0].clear() 
 
 
class BaseCamera(object): 
    thread = None  # background thread that reads frames from camera 
    frame = None  # current frame is stored here by background thread 
    last_access = 0  # time of last client access to the camera 
    event = CameraEvent() 
 
    def __init__(self): 
        """Start the background camera thread if it isn't running yet.""" 
        if BaseCamera.thread is None: 
            BaseCamera.last_access = time.time() 
 
            # start background frame thread 
            BaseCamera.thread = threading.Thread(target=self._thread) 
            BaseCamera.thread.start() 
 
            # wait until frames are available 
            while self.get_frame() is None: 
                time.sleep(0) 
 
    def get_frame(self): 
        """Return the current camera frame.""" 
        BaseCamera.last_access = time.time() 
 
        # wait for a signal from the camera thread 
        BaseCamera.event.wait() 
        BaseCamera.event.clear() 
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        return BaseCamera.frame 
 
    @staticmethod 
    def frames(): 
        """"Generator that returns frames from the camera.""" 
        raise RuntimeError('Must be implemented by subclasses.') 
 
    @classmethod 
    def _thread(cls): 
        """Camera background thread.""" 
        print('Starting camera thread.') 
        frames_iterator = cls.frames() 
        for frame in frames_iterator: 
            BaseCamera.frame = frame 
            BaseCamera.event.set()  # send signal to clients 
            time.sleep(0) 
 
            # if there hasn't been any clients asking for frames in 
            # the last 10 seconds then stop the thread 
            if time.time() - BaseCamera.last_access > 10: 
                frames_iterator.close() 
                print('Stopping camera thread due to inactivity.') 
                break 
        BaseCamera.thread = None 

 
Press ctrl+o first and hit the enter key on the keyboard. The file is saved now. 

18.  We have to create another file which is camera_pi.py 
 
Run 
sudo nano camera_pi.py 

 
Paste the following code into the file. 
 
import io 
import time 
import picamera 
from base_camera import BaseCamera 
 
 
class Camera(BaseCamera): 
    @staticmethod 
    def frames(): 
        with picamera.PiCamera() as camera: 
            # let camera warm up 
            time.sleep(2) 
 
            stream = io.BytesIO() 
            for _ in camera.capture_continuous(stream, 'jpeg', 
                                                 use_video_port=True): 
                # return current frame 
                stream.seek(0) 
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                yield stream.read() 
 
                # reset stream for next frame 
                stream.seek(0) 
                stream.truncate() 

 
Press ctrl+o first and hit the enter key on the keyboard. The file is saved now. 

19.  We have to install a package which is greenlet in order to ensure the camera can live 
stream. 
 
Run 
pip install greenlet 

 
You should be able to see a success message. The codes for the rpi components are done! 
Excited for the arduino part? Let’s do it! 

 

Section 6 
Arduino – Connecting the components 

 
One of the setup is for smart garage while the other one is for the bin. 

You may wish to power off your raspberrypi so as to have a safety precaution! 
 

  
  

CONNECT ARDUINO TO RASPBERRYPI 

1.  Plug one end of the blue usb b cable into the port on arduino. 

2.  Plug the other end of blue usb b cable into any of the usb ports in the raspberry pi.  

CONNECT 3V3 & GND TO POSITIVE AND NEGATIVE RAILS RESPECTIVELY 
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3.  Plug one end of red male-male jumper wire to the hole that corresponds to 5V. Plug the 
other end to the positive rail. The positive rail has a positive sign and has a red colour line. 

4.  Plug one end of black male-male jumper wire to the hole that corresponds to GND. Plug 
the other end to the negative rail. The negative rail has a negative sign and has a blue 
colour line. 

CONNECT HC-SR04 TO ARDUINO 

5.  Plug the HC-SR04 onto the breadboard as shown. 

6.  Plug one end of the black male-male jumper wire into the same column as the first leg of 
HC-SR04 (GND). 

7.  Plug the other end of the black male-male jumper wire into the negative rail. 

8.  Plug one end of the blue male-male jumper wire into the same column as the second leg 
of HC-SR04 (ECHO). 

9.  Plug the other end of the blue male-male jumper wire into the digital pin ~10. 

10.  Plug one end of the  male-male jumper wire into the same column as the third leg 
of HC-SR04 (TRIG). 

11.  Plug the other end of the  male-male jumper wire into the digital pin ~9. 

12.  Plug one end of the orange male-male jumper wire into the same column as the forth leg 
of HC-SR04 (VCC). 

13.  Plug the other end of the orange male-male jumper wire into the positive rail. We have 
finished the setup for HC-SR04. Now, let’s proceed to connecting LCD. 

CONNECT LCD DISPLAY TO ARDUINO 

14.  There are 4 pins at the back of the lcd display. 
 
Connect the pins on the lcd display to the arduino as indicated below. 
The jumper wires used are a male-female. 
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Jumper color LCD Display pin ARDUINO pin / 
Breadboard 

White SCL A5 
Orange SDA A4 
Green VCC Postive Rail on 

Breadboard 
Black GND Negative Rail on 

Breadboard 
 
We have completed the setup for connecting the lcd display! Now, we will move on to 
connecting PIR motion sensor. 

CONNECT PIR MOTION SENSOR TO ARDUINO 

15.  There are 3 pins underneath the pir motion sensor. 
 
Connect the pins on the pir motion sensor to the arduino as indicated below. 
The jumper wires used are a male-female. 
 

Jumper color PIR Motion 
Sensor Pin 

ARDUINO pin / 
Breadboard 

Black GND (on your 
left) 

Negative Rail on 
Breadboard 

Dark Pink SIGNAL ~ 11 
Red VCC Postive Rail on 

Breadboard 
 
We have completed the setup for connecting the pir motion sensor! Now, we will move on 
to connecting obstacle avoidance sensor. 

CONNECT OBSTACLE AVOIDANCE SENSOR TO ARDUINO 

16.  There are 3 pins on the obstacle avoidance sensor. 
 
Connect the pins on the obstacle avoidance sensor to the arduino as indicated below. 
The jumper wires used are a male-female. 
 

Jumper color Obstacle 
Avoidance 
Sensor Pin 

ARDUINO pin / 
Breadboard 

Dark Pink OUT 8 
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Brown GND Negative Rail on 
Breadboard 

Grey VCC Postive Rail on 
Breadboard 

 
We have completed the setup for connecting the obstacle avoidance sensor! Now, we will 
move on to connecting vibration sensor. 

CONNECT VIBRATION SENSOR TO ARDUINO 

17.  There are 3 pins on the vibration sensor. 
 
Connect the pins on the vibration sensor to the arduino as indicated below. 
The jumper wires used are a male-female. 
 

Jumper color Vibration Sensor ARDUINO pin / 
Breadboard 

Light Brown GND – ‘minus’ 
sign 

Negative Rail on 
Breadboard 

Red Middle Pin  5V on arduino 
Yellow SIGNAL ~3 

 
We have completed the setup for connecting the vibration sensor! Now, we will move on 
to coding to make these sensors/actuators work! 

 
This is the setup for the bin. 
 

  
  

CONNECT Load Cell to HX711 

3.  Most load cell have four wires: red, black, green and white. On the HX711 board you will 
find E+, E-, A+, A- and B+, B- connections. Connect load cell: 
Red wire to E+ 
Black wire to E- 
Green wire to A- 
White wire to A+ 
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4.  Connect the HX711 with the Arduino as follows: 
 

Jumper 
color 

HX711 pin Arduino 
pin 

Red VCC 5V 
Black GND GND 
Blue DT D3 
Purple SCK D2 
   

 

 

 

Section 7 
Arduino – Codes for the components 

 
One of the setup is for smart garage while the other one is for the bin. 

You may wish to power off your raspberrypi so as to have a safety precaution! 
 

PREPARATIONS 

Before we start creating files that are needed to run the arduino components, we have to 
create a folder. So that, our files are organised neatly. 
 
Remember to be in the directory (~/Garage_Parking) 
 
Typing this command in the command line will create a new folder in the directory 
(~/Garage_Parking).  
 
mkdir arduino_components 

You will see a folder created in the directory.  
To be in the folder, 
Type  
cd arduino_components 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 69 of 125  
 

We have to create a __init__.py file. So that the system can recognise this folder as a package 
and we can import files in this directory from another directory. Note that it is a double 
underscore not one. 
 
Run 
sudo nano __init__.py 

 

Make sure you have Arduino IDE installed! 
To check if you have installed 
Click on raspberry pi icon on the top left > Programming > Arduino IDE 
 

 
 
To install, go to https://www.arduino.cc/en/Main/Donate 

FileZilla should be installed, as files can be transferred to raspberrypi 
 
Download and install Filezilla on your laptop from https://filezilla-   
project.org/download.php?type=client 
 

Start Filezilla and click on “File->Site 
Manager”  
 

https://www.arduino.cc/en/Main/Donate
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Click on “New Site”, call it “Raspberry Pi”  
 
In the settings tab, enter the following: 
 

• Enter your RPi IP address as the Host 
• Select “SFTP” as the Protocol 
• Select “Normal” as Logon Type 

Enter username as “pi” and password as “robots1234” 

Click the “Connect” button.  You should see yourself connected to the Raspberry Pi and be 
able to view the entire contents of the files / folders after a while. 
 

 
 

  
  

CODE THE PROGRAM 

 The environment is ready for us to start coding now! 

100   Click on the Arduino IDE. 

101   Paste the following code into the file 
 
#include <Wire.h> 
#include <LiquidCrystal_I2C.h> 
 
// LCD 
LiquidCrystal_I2C lcd(your addr, 16, 2); // set the LCD address to  for a 
16 chars and 2 line display 
 
// Motion Sensor 
const int motionPin = 11; 
int motionValue = 0; 
 
// Ultrasonic Sensor 
const int trigPin = 9; 
const int echoPin = 10; 
long duration; 
int distance; 
 
// Shock Sensor 
const int shockPin = 3; // Use Pin 3 as Input 
int shockVal = HIGH; // This is where we record our shock measurement 
boolean bAlarm = false; 
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unsigned long lastShockTime; // Record the time that we measured a shock 
int shockAlarmTime = 250; // Number of milli seconds to keep the shock 
alarm high 
 
// Obstacle Avoidance Sensor 
const int oaPin = 8; 
 
void setup() { 
 
  Serial.begin(9600); 
 
  lcd.init(); 
  lcd.backlight(); 
  lcd.setCursor(0, 0); 
  lcd.print("Detection: "); 
 
  //Motion sensor 
  pinMode (motionPin, INPUT); 
 
  // Ultrasonic Sensor 
  pinMode(trigPin, OUTPUT); 
  pinMode(echoPin, INPUT); 
 
  // Obstacle Avoidance Sensor 
  pinMode(oaPin, INPUT); 
 
  // Shock Sensor 
  pinMode (shockPin, INPUT) ; 
} 
 
void detectShock () 
{ 
 
  shockVal = digitalRead (shockPin) ; // read the value from our sensor 
 
  if (shockVal == LOW) // If we're in an alarm state 
  { 
    lastShockTime = millis(); // record the time of the shock 
    // The following is so we  don't scroll on the output screen 
    if (!bAlarm) { 
      lcd.setCursor (0, 0); 
      lcd.print("Shock Detection: "); 
      lcd.setCursor(0, 1); 
      lcd.print("Shock is Present"); 
      Serial.println("present"); 
      bAlarm = true; 
    } 
  } 
  else 
  { 
    if ( (millis() - lastShockTime) > shockAlarmTime  &&  bAlarm) { 
      lcd.setCursor (0, 0); 
      lcd.print("Shock Detection: "); 
      lcd.setCursor(0, 1); 
      lcd.print("Shock is Absent."); 
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      Serial.println("absent"); 
      bAlarm = false; 
    } 
  } 
} 
 
void senseObstacle() { 
  if (digitalRead(oaPin) == LOW) { 
    lcd.setCursor(0, 1); 
    lcd.print("Obstacle Present"); 
  } else { 
    lcd.setCursor(0, 1); 
    lcd.print("Obstacle Absent."); 
  } 
} 
 
void loop() { 
 
  static int state = 1; // initial state is 1, the "idle" state. 
  static unsigned long ts;  // To store the "current" time in for delays. 
 
  switch (state) 
  { 
    case 1: 
      lcd.clear(); 
      lcd.setCursor(0, 0); 
      lcd.print("Detection: "); 
      state = 2; 
      break; 
    case 2: 
      motionValue = digitalRead(motionPin); 
 
      if (motionValue == HIGH) 
      { 
        lcd.clear(); 
        lcd.setCursor (0, 0); 
        lcd.print("Detection: "); 
        lcd.setCursor(0, 1); 
        lcd.print("Door opens"); 
        delay(500); 
        ts = millis();  // Remember the current time 
        state = 3; 
      } 
      else { 
        lcd.setCursor(0, 1); 
        lcd.print("Door is not open"); 
        state = 2; 
      } 
      break; 
    case 3: 
      if (millis() - ts < 5000) { 
        senseObstacle(); 
      } else  { 
        lcd.clear(); 
        state = 4; 
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      } 
      break; 
    case 4: 
 
      // Clears the trigPin 
 
      digitalWrite(trigPin , LOW); 
      delayMicroseconds(2); 
 
      digitalWrite(trigPin, HIGH); 
      delayMicroseconds(10); 
      digitalWrite(trigPin , LOW); 
 
      // Reads the echoPin, returns the sound wave 
      // travel time in microseconds 
      duration = pulseIn(echoPin , HIGH); 
      distance = duration * 0.034 / 2; 
      lcd.setCursor(0, 0); 
      lcd.print("Distance left: "); 
 
      lcd.setCursor(0, 1); 
      lcd.print(distance); 
      lcd.print(" CM"); 
      if (distance == 4) { 
        lcd.setCursor(0, 1); 
        lcd.print("Stop here"); 
        ts = millis(); 
        state = 5; 
      } 
      break; 
 
    case 5: 
      if (millis() - ts < 4000) { //if driver is "blur" and drive 
backwards to the wall. 
 
        detectShock(); // will start print on led if shock is present. 
      } else { 
        delay(5000); 
        state = 1;  //continue back to the first part. 
      } 
      break; 
  } 
} 
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102   We have to import the LiquidCrystal_I2C library. I have provided the library in the 
resources folder.  
 
You can transfer the resources folder to the raspberrypi via FileZilla. In order to transfer, 
make sure you have browse to the correct destination path(Garage_Parking > 
arduino_components) on your right. Then right click on the folder you want to transfer > 
click on upload. Successful file transfer will appear in the Successful transfers tab at the 
bottom. 
 

 

103   To import the library in Arduino, click on sketch > Import Library > Add Library 
 

 

104   Click on Garage_Parking > resources > LiquidCrystal_I2C. 
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You should be able to see the LiquidCrystal_I2C under Contributed heading.  

105   If you happen to see that the first parameter for the lcd method has a placeholder called 
‘your addr’, you have to put the addr of your lcd. 
 
So, how do you know your addr? 
 
Firstly, click on the small arrow pointing downwards at the right. The dialog will appear to 
ask for the input of file, type Icd and hit ok. 
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106   Paste the code into the file 
 

. // -------------------------------------- 

. // i2c_scanner 

. // 

. // Version 1 

. //    This program (or code that looks like it) 

. //    can be found in many places. 

. //    For example on the Arduino.cc forum. 

. //    The original author is not know. 

. // Version 2, Juni 2012, Using Arduino 1.0.1 
0. //     Adapted to be as simple as possible by Arduino.cc 
user Krodal 

1. // Version 3, Feb 26  2013 
2. //    V3 by louarnold 
3. // Version 4, March 3, 2013, Using Arduino 1.0.3 
4. //    by Arduino.cc user Krodal. 
5. //    Changes by louarnold removed. 
6. //    Scanning addresses changed from 0...127 to 1...119, 
7. //    according to the i2c scanner by Nick Gammon 
8. //    http://www.gammon.com.au/forum/?id=10896 
9. // Version 5, March 28, 2013 
0. //    As version 4, but address scans now to 127. 
1. //    A sensor seems to use address 120. 
2. // Version 6, November 27, 2015. 
3. //    Added waiting for the Leonardo serial communication. 
4. // 
5. // 
6. // This sketch tests the standard 7-bit addresses 
7. // Devices with higher bit address might not be seen 
properly. 

8. // 
9.   
0. #include <Wire.h> 
1.   
2.   
3. void setup() 
4. { 
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5.   Wire.begin(); 
6.   
7.   Serial.begin(9600); 
8.   while (!Serial);             // Leonardo: wait for serial 
monitor 

9.   Serial.println("\nI2C Scanner"); 
0. } 
1.   
2.   
3. void loop() 
4. { 
5.   byte error, address; 
6.   int nDevices; 
7.   
8.   Serial.println("Scanning..."); 
9.   
0.   nDevices = 0; 
1.   for(address = 1; address < 127; address++ ) 
2.   { 
3.     // The i2c_scanner uses the return value of 
4.     // the Write.endTransmisstion to see if 
5.     // a device did acknowledge to the address. 
6.     Wire.beginTransmission(address); 
7.     error = Wire.endTransmission(); 
8.   
9.     if (error == 0) 
0.     { 
1.       Serial.print("I2C device found at address 0x"); 
2.       if (address<16) 
3.         Serial.print("0"); 
4.       Serial.print(address,HEX); 
5.       Serial.println("  !"); 
6.   
7.       nDevices++; 
8.     } 
9.     else if (error==4) 
0.     { 
1.       Serial.print("Unknown error at address 0x"); 
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2.       if (address<16) 
3.         Serial.print("0"); 
4.       Serial.println(address,HEX); 
5.     }     
6.   } 
7.   if (nDevices == 0) 
8.     Serial.println("No I2C devices found\n"); 
9.   else 
0.     Serial.println("done\n"); 
1.   
2.   delay(5000);           // wait 5 seconds for next scan 
3. } 
 
 

107   Click on the second button from your left.  
 
 
 
Within moments, your address should 
appear. Remember to replace it in the 
uno file!  

108   You can remove the lcd file now. Click on the 
arrow pointing downwards > click Ok. 
 
 

109   You can run the garageparking file now by clicking on the 
second button from your left. The lcd should be powered on 
and you can interact with the sensors. 
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110   Save the sketch by clicking on file at the top left hand. Then enter the name as follow and 
save it in Garage_Parking/arduino_components. 
 

 

RECEIVE DATA FROM VIBRATION SENSOR 

111   Go to directory (~/Garage_Parking/arduino_components/garageparking), type  
sudo nano insertShock.py 

112   Paste the following code  
from serial import * 
import datetime 
import uuid 
import os,sys 
current_directory = os.getcwd() 
parent_directory = os.path.dirname(current_directory) 
upper_parent = os.path.dirname(parent_directory) 
 
sys.path.insert(0, upper_parent) 
 
import aws_connection 
 
ser = Serial ('/dev/ttyUSB0', 9600) 
 
# connect to aws 
garageParking = aws_connection.connectToAWS() 
 
 
while (True): 
    data = ser.readline() 
    fD = data.strip() 
    currentDT = datetime.datetime.now() 
    newId = uuid.uuid4() 
    try: 
        mqtt_message = "{\"Shock_Id\":\"" + str(newId) + "\" , 
\"Status\":\"" + str(fD) + "\" , \"Time_Stamp\":\"" + str(currentDT) + 
"\"}" 
        garageParking.publish("GarageParking/1/ShockData", mqtt_message, 
1) 
    except ValueError: 
        print(ValueError) 
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113   You can run this file later as the database has not been set up yet. 
python insertShock.py 

 
 
This is the arduino code for the bin. 

N
o. 

Task 

a)  Install the packages required to run the code in the weight_lcd.ino file                 HX711 
- https://github.com/bogde/HX711 
Newliquidcrystal - https://bitbucket.org/fmalpartida/new-liquidcrystal/downloads/ 

b)  To include libraries into your arduino IDE, click on Sketch > Include Library > Manage 
Libraries. Select the folder that you have just downloaded to include the library.

 

c)  Before uploading the weight_lcd.ino file to the arduino, the calibration factor must be 
determined first. Type the following code in calibration.ino file.  

 

https://github.com/bogde/HX711
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#include "HX711.h"   
  
#define DOUT  3 
#define CLK  2 
  
HX711 scale(DOUT, CLK); 
  
//Change this calibration factor as per your load cell once it is found you 
many need to vary it in thousands 
float calibration_factor = -96650; 
  
//==========================================================================
=================== 
//                         SETUP 
//==========================================================================
=================== 
void setup() { 
  Serial.begin(9600); 
  Serial.println("HX711 Calibration"); 
  Serial.println("Remove all weight from scale"); 
  Serial.println("After readings begin, place known weight on scale"); 
  Serial.println("Press a,s,d,f to increase calibration factor by 
10,100,1000,10000 respectively"); 
  Serial.println("Press z,x,c,v to decrease calibration factor by 
10,100,1000,10000 respectively"); 
  Serial.println("Press t for tare"); 
  scale.set_scale(); 
  scale.tare(); //Reset the scale to 0 
  
  long zero_factor = scale.read_average(); //Get a baseline reading 
  Serial.print("Zero factor: "); //This can be used to remove the need to 
tare the scale. Useful in permanent scale projects. 
  Serial.println(zero_factor); 
} 
  
//==========================================================================
=================== 
//                         LOOP 
//==========================================================================
=================== 
void loop() { 
  
  scale.set_scale(calibration_factor); //Adjust to this calibration factor 
  
  Serial.print("Reading: "); 
  Serial.print(scale.get_units(), 3); 
  Serial.print(" kg"); //Change this to kg and re-adjust the calibration 
factor if you follow SI units like a sane person 
  Serial.print(" calibration_factor: "); 
  Serial.print(calibration_factor); 
  Serial.println(); 
  
  if(Serial.available()) 
  { 
    char temp = Serial.read(); 
    if(temp == '+' || temp == 'a') 
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Section 8 
Web Application – Codes to set up web 

application 
 

  
  

PREPARATIONS 

      calibration_factor += 10; 
    else if(temp == '-' || temp == 'z') 
      calibration_factor -= 10; 
    else if(temp == 's') 
      calibration_factor += 100;   
    else if(temp == 'x') 
      calibration_factor -= 100;   
    else if(temp == 'd') 
      calibration_factor += 1000;   
    else if(temp == 'c') 
      calibration_factor -= 1000; 
    else if(temp == 'f') 
      calibration_factor += 10000;   
    else if(temp == 'v') 
      calibration_factor -= 10000;   
    else if(temp == 't') 
      scale.tare();  //Reset the scale to zero 
  } 
} 
//==========================================================================
=================== 
 

 

d)  After determining the calibration factor, replace the value in  weight_lcd.ino  file and 
press the upload button to save the code in the arduino 
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Before we start creating files that are needed, we have to create folders. So that, our files are 
organised neatly. 
 
Remember to be in the directory (~/Garage_Parking) 
 
Typing this command in the command line will create a new folder in the directory 
(~/Garage_Parking). Static folder is used to hold cascading style sheets, javascript and images. 
 
As the resource folder is in your directory, you can copy the static folder out and paste it in 
~/Garage_Parking.  
 
There is another folder to be created which is templates. Templates folder are used to hold 
html files. 
mkdir templates 

 
 

  
  

CODE THE PROGRAM 

 Now, we will be creating the web application. 

1.  Go to the templates directory (~/Garage_Parking/templates) 
cd templates 

2.  In the templates folder, a index.html is the home page of the application. 
 
type 
sudo nano index.html  

3.  Paste the following code 
 
<!DOCTYPE html> 
 
<html> 
 
<head> 
    <meta charset="utf-8"> 
    <meta name="viewport" content="width=device-width"> 
    <link type="text/html" rel="stylesheet" href="../static/styles.css" 
/> 
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    <link type="text/css" rel="stylesheet" 
href="../static/materialize/css/materialize.min.css" 
media="screen,projection" /> 
    <link href="https://fonts.googleapis.com/icon?family=Material+Icons" 
rel="stylesheet"> 
    <link 
href="http://mottie.github.io/tablesorter/css/theme.default.css" 
rel="stylesheet"> 
    <script type="text/javascript" src="http://code.jquery.com/jquery-
latest.min.js"></script> 
    <script type="text/javascript" 
src="../static/materialize/js/materialize.js"></script> 
    <script type="text/javascript" 
src="../static/js/pagination.js"></script> 
    <script type="text/javascript" 
src="https://www.gstatic.com/charts/loader.js"></script> 
    <script type="text/javascript" 
src="https://cdnjs.cloudflare.com/ajax/libs/jquery.tablesorter/2.9.1/jque
ry.tablesorter.min.js"></script> 
</head> 
 
<body class="yellow lighten-2"> 
    <div id="container"> 
        <div class="row"> 
           <!--drop down--> 
            <ul id="dropdown" class="dropdown-content"> 
                <li> 
                    <a href="/logout"> 
                        Log Out 
 
                    </a> 
 
                </li> 
            </ul> 
            <ul id="dropdownformobile" class="dropdown-content"> 
                <li> 
                    <a href="/logout"> 
                        Log Out 
                    </a> 
 
                </li> 
            </ul> 
            <nav class="blue accent-2"> 
                <div class="nav-wrapper"> 
                    <a class="brand-logo">Garage App</a> 
                    <a data-target="mobile" class="sidenav-trigger"> 
                        <i class="material-icons">menu</i> 
                    </a> 
                    <ul class="right hide-on-med-and-down"> 
                        <li> 
                            <a href="/ir">Image Recognition</a> 
                        </li> 
                        <li> 
                            <a href="/interact">Interact</a> 
                        </li> 
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                        <li> 
                            <a href="/index">Dashboard</a> 
                        </li> 
                        <li> 
                            <a class="dropdown-trigger" data-
target="dropdown"> 
                               {{ current_user.firstname + " " + 
current_user.lastname }} 
                                <i class="material-icons 
right">arrow_drop_down</i> 
                            </a> 
                        </li> 
                    </ul> 
                </div> 
 
            </nav> 
            <ul class="sidenav" id="mobile"> 
                <li> 
                    <a href="/ir">Image Recognition</a> 
                </li> 
                <li> 
                    <a href="/interact">Interact</a> 
                </li> 
                <li> 
                    <a href="/index">Dashboard</a> 
                </li> 
                <li> 
                    <a class="dropdown-trigger" data-
target="dropdownformobile"> 
                        {{ current_user.firstname + " " + 
current_user.lastname }} 
                        <i class="material-icons 
right">arrow_drop_down</i> 
                    </a> 
                </li> 
            </ul> 
        </div> 
 
        <div id="main"> 
            <h3 class="center-align">Overview</h3> 
            <div class="row"> 
                <div class="col l6 s12 m12 "> 
                    <h4>Security Access Records</h4> 
                    <nav> 
                       <div class="nav-wrapper blue accent-2"> 
                       <form> 
                           <div class="input-field"> 
                              <input id="search" type="search" required 
placeholder="Search..."> 
                              <label class="label-icon" for="search"><i 
class="material-icons">search</i></label> 
                              <i class="material-icons">close</i> 
                           </div> 
                       </form> 
                       </div> 
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                   </nav> 
                    <table class="highlight" id="sAT" 
class="tablesorter"> 
                        <thead> 
                            <tr> 
                                <th>Id</th> 
                                <th>Intrusion Detected</th> 
                                <th>Time</th> 
                            </tr> 
                        </thead> 
 
                        <tbody id="securityATable"> 
                        {% for record in aRecords %} 
                            <tr> 
                                <td>{{record.PAId}}</td> 
                                <td>{{record.IntrusionDetected}}</td> 
                                <td>{{record.TimeStamp}}</td> 
                            </tr> 
                        {% endfor %} 
                        </tbody> 
                    </table> 
                    <div class="center text-center"> 
                        <ul class="pagination pager" id="pager"></ul> 
                    </div> 
                </div> 
                <div class="col l6 s11 m11"> 
                    <h4>Shock Chart</h4> 
                    <div id="shock_chart" style="height: 400px;"> 
                    </div> 
                </div> 
            </div> 
             <div class="row"> 
                <div class="col l6 s12 m12 "> 
                    <h4>Weight Records</h4> 
                    <p>Interested to know the weight of the bin so that 
you know when to clear?</p> 
                    <nav> 
                       <div class="nav-wrapper blue accent-2"> 
                       <form> 
                           <div class="input-field"> 
                              <input id="searchWeight" type="search" 
required placeholder="Search..."> 
                              <label class="label-icon" for="search"><i 
class="material-icons">search</i></label> 
                              <i class="material-icons">close</i> 
                           </div> 
                       </form> 
                       </div> 
                   </nav> 
                    <table class="highlight" id="wT" class="tablesorter"> 
                        <thead> 
                            <tr> 
                                <th>Time</th> 
                                <th>Weight</th> 
                            </tr> 
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                        </thead> 
                        <tbody id="weightC"> 
                           {% for timeinfo, valueinfo in weightData %} 
                           <tr> 
                               <td>{{ timeinfo 
}}</td><td>{{valueinfo}}</td> 
                           </tr> 
                           {% endfor %} 
                        </tbody> 
                    </table> 
                    <div class="center text-center"> 
                        <span class="left" id="total_reg"></span> 
                        <ul class="pagination pager" id="pagerW"></ul> 
                    </div> 
                </div> 
                <div class="col l6 s11 m11"> 
                    <h4>Weight Chart</h4> 
                    <div id="weightChart" style="height: 400px;"></div> 
                </div> 
            </div> 
        </div> 
 
    </div> 
 
     
    <script type = "text/javascript"> 
            
        $(document).ready(function () { 
             
         google.charts.load('current', {'packages':['corechart']});   
         google.charts.setOnLoadCallback(drawChart);   
          
          function drawChart()   
          {   
            var data = google.visualization.arrayToDataTable([ 
                ['Shock', 'Number'], 
                {% for r in sD %}     
                ['{{r.shockStatus}}', {{r.number}}], 
                {% endfor %} 
             
            ]); 
                var options = {   
                      title: 'Percentage of Shock Existence',   
                         
                       
                     };   
                var chart = new 
google.visualization.PieChart(document.getElementById('shock_chart'));   
                chart.draw(data, options);   
           } 
              google.charts.setOnLoadCallback(drawWeightChart); 
              const arr = []; 
              {%- for timeinfo, valueinfo in weightData %} 
              arr.push([new Date("{{ timeinfo }}"), {{ valueinfo }}]); 
              {%- endfor %} 
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              arr.sort((elem1, elem2) => elem1[0] - elem2[0]) 
    
              function drawWeightChart() { 
                  var dataTable = new google.visualization.DataTable(); 
                  dataTable.addColumn('datetime', 'Time'); 
                  dataTable.addColumn('number', 'Dustbin'); 
                  dataTable.addRows(arr); 
                  now = new Date() 
           let tenMinutesAgo = now - 1000 * 10 * 60 
           tenMinutesAgo = new Date(tenMinutesAgo) 
           let twentyMinutesAgo = tenMinutesAgo - 1000 * 10 * 60  
           twentyMinutesAgo = new Date(twentyMinutesAgo) 
           let thirtyMinutesAgo = twentyMinutesAgo - 1000 * 10 * 60 
           thirtyMinutesAgo = new Date(thirtyMinutesAgo) 
                 var chart = new 
google.visualization.LineChart(document.getElementById('weightChart')); 
                 chart.draw(dataTable, {title: 'Weight of dustbin', 
legend: {position: 'right'}, 
                              colors: ['#A0D100'], curveType: 'function', 
                             hAxes: { 
                                 0: { 
                                     title: 'Time', 
                                     ticks: [now, tenMinutesAgo, 
twentyMinutesAgo, thirtyMinutesAgo] 
                                 } 
                             }, 
                              vAxes: { 
                                  0: { 
                                      title: 'Weight(kg)' 
                                  } 
                              }, 
        }); 
            } 
            $(".dropdown-trigger ").dropdown(); 
            $('.sidenav').sidenav(); 
            $('#securityATable').pageMe({ 
              pagerSelector:'#pager', 
              activeColor: 'blue', 
              perPage: 10, 
              showPrevNext: true, 
              hidePageNumbers: false 
            }) 
            $('#weightC').pageMe({ 
              pagerSelector:'#pagerW', 
              activeColor: 'blue', 
              perPage: 10, 
              showPrevNext: true, 
              hidePageNumbers: false 
            }) 
             
            $('#sAT').tablesorter({widgets: ['zebra']}); 
            $('#wT').tablesorter({widgets: ['zebra']}); 
            $("#search").on("keyup", function() { 
             var value = $(this).val().toLowerCase(); 
             $("#securityATable tr").filter(function() { 
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             $(this).toggle($(this).text().toLowerCase().indexOf(value) > 
-1) 
            }); 
            }); 
            $("#searchWeight").on("keyup", function() { 
             var value = $(this).val().toLowerCase(); 
             $("#weightC tr").filter(function() { 
             $(this).toggle($(this).text().toLowerCase().indexOf(value) > 
-1) 
            }); 
            }); 
             
            setInterval(function () { 
                location.reload(); 
            }, 5000); 
          }); 
          
        
         
    </script> 
    <script type="text/javascript " 
src="../static/materialize/js/materialize.min.js "></script> 
</body> 
 
</html> 
 

4.  Remember to save the file by hitting ctrl o + enter key! Hit ctrl + z to exit. 

5.  In the templates folder, a login.html is the login page of the application. 
type 
sudo nano login.html 

6.  Paste the following code 
<!DOCTYPE html> 
 
<html> 
 
<head> 
    <meta charset="utf-8"> 
    <meta name="viewport" content="width=device-width"> 
    <link type="text/css" rel="stylesheet" href="../static/styles.css" /> 
    <!--{{ url_for('static', filename='/styles.css') }}--> 
    <link type="text/css" rel="stylesheet" 
href="../static/materialize/css/materialize.min.css" 
media="screen,projection" /> 
    <link href="https://fonts.googleapis.com/icon?family=Material+Icons" 
rel="stylesheet"> 
    <script src='https://www.google.com/recaptcha/api.js'></script> 
</head> 
 
<body> 
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    <div id="container"> 
        <div class="row l_row"> 
            <div class="col s12 l4 offset-l4"> 
                <form class="card" method="POST" action="/login"> 
                    <div class="card-content light-blue accent-2"> 
                        <h3 class="center">Sofia's Garage Parking</h3> 
                    </div> 
                    <div class="l_components"> 
                        <div class="input-field"> 
                            <label for="username">Username</label> 
                            <input id="username" type="text" 
class="validate" name="username" required> 
                        </div> 
                        <div class="input-field"> 
                            <label for="password">Password</label> 
                            <input id="password" type="password" 
class="validate" name="password" required> 
                        </div> 
                        <p class="form-field"> 
                            <label> 
                                <input type="checkbox" class="filled-in" 
name="remMe" id="remMe" /> 
                                <span>Remember Me</span> 
                            </label> 
                        </p> 
                        <div class="g-recaptcha" data-
sitekey="6LdFZGoUAAAAACKEz8G7ngzp5C01um1swoRVmfmF" name="g-recaptcha-
response" style="margin-top: 20px;"></div> 
                        <div class="l_button right-align"> 
                            <button class="waves-effect waves-light btn-
large light-blue accent-2 black-text" type="submit""> 
                                <i class="material-icons right"> 
                                    exit_to_app 
                                </i> 
                                login 
                            </button> 
                        </div> 
                    </div> 
                </form> 
            </div> 
            <!-- 
            <h2 class="center header">Garage Parking</h2> 
            <form class="loginform col l4 m12 s12 offset-l4"> 
                <div class="row"> 
                    <div class="username input-field col l10 m6 s12"> 
                        <input id="username" type="text" class="validate 
"> 
                        <label for="username">Username</label> 
                    </div> 
                </div> 
                <div class="row"> 
                    <div class="input-field col m6 s12"> 
                        <input id="password" type="password" 
class="validate"> 
                        <label for="password">Password</label> 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 91 of 125  
 

  
  

                    </div> 
                </div> 
            </form> 
             --> 
        </div> 
 
    </div> 
 
    <script type="text/javascript" 
src="../static/materialize/js/materialize.min.js"></script> 
    <script type = "text/javascript"> 
      {% if errMsg: %}  
      M.toast({html: '{{errMsg}}'}) 
     {% endif %} 
    </script> 
</body> 
 
</html> 

7.  Remember to save the file by hitting ctrl o + enter key! Hit ctrl + z to exit. 

8.  A unauthorised view is required to show to unauthorised users. 

9.  Type 
sudo nano logout.html 

10.  Paste the following code 
<!DOCTYPE html> 
 
<html> 
 
<head> 
    <meta charset="utf-8"> 
    <meta name="viewport" content="width=device-width"> 
    <link type="text/css" rel="stylesheet" href="../static/styles.css" /> 
<!-- {{ url_for('static', filename='/styles.css') }} --> 
    <link type="text/css" rel="stylesheet" 
href="../static/materialize/css/materialize.min.css" 
media="screen,projection" /> 
    <link href="https://fonts.googleapis.com/icon?family=Material+Icons" 
rel="stylesheet"> 
</head> 
 
<body> 
    <div id="container"> 
        <div class="row l_row"> 
            <div class="col s12 l4 offset-l4"> 
                <form class="card"> 
                    <div class="card-content light-blue accent-2"> 
                        <h3 class="center">Sofia's Garage Parking</h3> 
                    </div> 
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                    <div class="row center"> 
                        <h4 class="col m12 s12">You are not 
authorised</h4> 
                    </div> 
                </form> 
            </div> 
        </div> 
 
    </div> 
 
    <script type="text/javascript" 
src="../static/materialize/js/materialize.min.js"></script> 
</body> 
 
</html> 

11.  Remember to save the file by hitting ctrl o + enter key! Hit ctrl + z to exit. 

12.  A user model is needed in the models folder. 
 
Run 
sudo nano ~/Garage_Parking/models/User 

13.  Paste the following code 
 
from flask_login import UserMixin 
 
class User(UserMixin):  #User class for login 
    def __init__(self, id, username, first_name, last_name, active=True): 
        self.id = id 
        self.username = username 
        self.firstname = first_name 
        self.lastname = last_name 
        self.active = active 
 
    def is_anonymous(self): 
        return False 
 
    def is_authenticated(self): 
        return True 

 
  

14.  Remember to save the file by hitting ctrl o + enter key! Hit ctrl + z to exit. 

15.  As we are in the templates directory, we need to jump one level up. 
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cd .. 

16.  The database.py is needed. 
sudo nano database.py 

17.  Paste the following code 
import boto3 
 
def getResource(): 
# Get the service resource. 
    dynamodb = boto3.resource('dynamodb') 
 
 
    return dynamodb 

 
 

18.  Remember to save the file by hitting ctrl o + enter key! Hit ctrl + z to exit. 

19.  The server.py is needed. 
sudo nano server.py 

20.  Paste the following code 
from importlib import import_module 
from flask import Flask, render_template, request, url_for, redirect, 
Response, session, flash 
from flask_login import LoginManager, login_required, login_user, 
logout_user, current_user 
import hashlib, os, datetime 
import aws_connection 
import database 
from models import User 
from rpi_components import GP_Lights, weight 
from boto3.dynamodb.conditions import Attr 
import requests, json 
 
# import camera driver 
if os.environ.get('CAMERA'): 
    Camera = import_module('camera_' + os.environ['CAMERA']).Camera 
else: 
    from models import camera_pi 
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app = Flask(__name__) 
app.secret_key = os.urandom(24).encode('hex')  # secret for session 
 
 
login_manager = LoginManager() 
login_manager.init_app(app) 
login_manager.session_protection = "strong" 
 
# connect to aws 
garageParking = aws_connection.connectToAWS() 
 
# Get Resource 
dynamoDb = database.getResource() 
 
@app.before_request 
def before_request(): 
    session.permanent = True  # create new session 
    app.permanent_session_lifetime = datetime.timedelta( 
        minutes=20)  # session expires after this 
    session.modified = True 
 
@login_manager.user_loader 
def load_user(user_id): 
    userTable = dynamoDb.Table('User') 
    response = 
userTable.scan(FilterExpression=Attr('User_Id').eq(str(user_id))) 
    record = response['Items'] 
    for r in record: 
        passwordDb = r['Password'] 
        userId = r['User_Id'] 
        username = r['Username'] 
        first_name = r['First_Name'] 
        last_name = r['Last_Name'] 
    return User.User(userId, username, first_name, last_name) 
 
 
def is_human(captcha_response): 
    """ Validating recaptcha response from google server 
        Returns True captcha test passed for submitted form else returns 
False. 
    """ 
    secret = "6LdFZGoUAAAAACKEz8G7ngzp5C01um1swoRVmfmF" 
    payload = {'response':captcha_response, 'secret':secret} 
    response = 
requests.post("https://www.google.com/recaptcha/api/siteverify", payload) 
    response_text = json.loads(response.text) 
    return response_text['success'] 
 
@app.route('/login', methods=['POST', 'GET']) 
def login(): 
    if(current_user.is_authenticated):   #check whether they are already 
authenticated 
        return redirect(url_for("index")) 
 
    if request.method == 'POST': 
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        loginData = request.form 
        username = loginData['username'] 
        password = loginData['password'] 
        captcha_response = loginData['g-recaptcha-response'] 
 
        rememberMeCheckBox = loginData.get('remMe') 
 
        if(rememberMeCheckBox == "on"):  # check whether remember me 
checkbox is ticked 
            rememberMe = True 
        else: 
            rememberMe = False 
         
        userTable = dynamoDb.Table('User') 
        response = 
userTable.scan(FilterExpression=Attr('Username').eq(str(username))) 
        record = response['Items'] 
        status = "" 
        if(len(record) > 0): 
            passwordSalt = "" 
            passwordDb = "" 
            for r in record: 
                passwordSalt = r['Password_Salt'] 
                passwordDb = r['Password'] 
                userId = r['User_Id'] 
                username = r['Username'] 
                first_name = r['First_Name'] 
                last_name = r['Last_Name'] 
            user_hashedpw = hashlib.sha512(passwordSalt.encode( 
                'utf-8') + password.encode('utf-8')).hexdigest() 
            if (user_hashedpw == passwordDb): 
                gp_user = User.User(userId, username, 
                               first_name, last_name) 
                login_user(gp_user, remember=rememberMe) 
                if is_human(captcha_response): 
                    # Process request here 
                    return redirect(url_for("index")) 
                else: 
                    # Log invalid attempts 
                    status="Please verify that you are a human" 
                    errMsg=status 
                    return render_template('login.html', errMsg=status) 
            else: 
                status = "Password is wrong" 
                return render_template('login.html', errMsg=status) 
        else: 
            status = "User does not exist" 
            return render_template('login.html', errMsg=status) 
         
 
 
    return render_template('login.html') 
 
light = GP_Lights.Light() 
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# Custom MQTT message callback 
def onLightCallBack(client, userdata, message): 
 print("Received a new message: ") 
 print(message.payload) 
 print("from topic: ") 
 print(message.topic) 
 print("--------------\n\n") 
         
 
# Custom MQTT message callback 
def offLightCallBack(client, userdata, message): 
 print("Received a new message: ") 
 print(message.payload) 
 print("from topic: ") 
 print(message.topic) 
 print("--------------\n\n") 
         
 
@app.route('/index', defaults={'path': ''}) 
@login_required 
def index(path): 
    shockStatusFalse = [] 
    shockStatusTrue = [] 
    total = []  
    paTable = dynamoDb.Table('PhysicalAccess') 
    response = paTable.scan() 
    securityAR = response['Items'] 
    sTable = dynamoDb.Table('Shock') 
    response = sTable.scan() 
    shockData = response['Items'] 
    for record in shockData: 
        if(record['Status'] == "absent"): 
            shockStatusFalse.append(record['Status']) 
        else: 
            shockStatusTrue.append(record['Status']) 
    shockStatusFalseLength = len(shockStatusFalse) 
    shockStatusTrueLength = len(shockStatusTrue) 
    shockGroupFalse = {"number": shockStatusFalseLength, "shockStatus": 
"absent"} 
    shockGroupTrue = {"number": shockStatusTrueLength, "shockStatus": 
"present"} 
    total.append(shockGroupFalse) 
    total.append(shockGroupTrue) 
    currentStatus = "" 
    data = weight.retrieveData() 
 
    return render_template('index.html', aRecords=securityAR, sD=total, 
weightData=data) 
 
@app.route('/interact', defaults={'path': ''}) 
@app.route('/interact/<path:path>') 
@login_required 
def interact(path): 
    currentStatus = "" 
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    if(path == "onLight"): 
        lightValue = "Garage light is on" 
        garageParking.publish("GarageParking/1/Light", lightValue, 1) 
        garageParking.subscribe("GarageParking/1/Light", 1, 
onLightCallBack) 
        light.remoteOnLight() 
        currentStatus = "On" 
        return render_template('interact.html',lightStatus=currentStatus) 
    elif (path == "offLight"): 
        lightValue = "Garage light is off" 
        garageParking.publish("GarageParking/1/Light", lightValue, 1) 
        garageParking.subscribe("GarageParking/1/Light", 1, 
offLightCallBack) 
        light.remoteOffLight() 
        currentStatus = "Off" 
        return render_template('interact.html', 
lightStatus=currentStatus) 
     
    return render_template('interact.html', lightStatus=currentStatus) 
 
def gen(camera): 
    while True: 
        frame = camera.get_frame() 
        yield (b'--frame\r\n' 
               b'Content-Type: image/jpeg\r\n\r\n' + frame + b'\r\n') 
 
@app.route('/live_stream') 
@login_required 
def video_feed(): 
 
    return Response(gen(camera_pi.Camera()), 
                    mimetype='multipart/x-mixed-replace; boundary=frame') 
 
# Logout 
@app.route("/logout") 
@login_required 
def logout(): 
    logout_user() 
    return redirect(url_for("login")) 
 
# if they are not logged in and attempts to access unauthorised pages, 
they will hit this error 
 
@login_manager.unauthorized_handler 
def unauthorized(): 
    return render_template("logout.html") 
 
# ash = hashlib.sha512(salt.encode('utf-8') + pw.encode('utf-
8')).hexdigest() 
 
 
@app.route("/weight") 
def weightPage(): 
    return render_template('weight.html', weightData = 
weight.retrieveData()) 
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if __name__ == "__main__": 
    app.run(host='0.0.0.0', debug=True, threaded=True) 

21.  Remember to save the file by hitting ctrl o + enter key! Hit ctrl + z to exit. 

22.  You are ready to run the web application now! 
python server.py 

23.  Go to http://yourrpiaddr:5000/login 

 

Section 9 
Face dashboard 

  
  

CODE THE PROGRAM 

 Now, we will be creating the frontend dashboard for facial recognition 

1. Cd back into your CF folder 
cd ~/CF 

 
Type in the directory, type in either of the following commands to create a base react app 
 
npx (npx comes with npm 5.2+ and higher, see instructions for older npm versions) 
npx create-react-app cf-react-frontend 
 
OR 
 
npm (npm init <initializer> is available in npm 6+) 
npm init react-app cf-react-frontend 
 
OR 
 
Yarn 
yarn create react-app cf-react-frontend 
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2. Once the app is created, cd into your app and open with code or any other ide 
cd ~/CF/cf-react-frontend 
~/CF/cf-react-frontend code . 

3. You can test if your app is working or not by typing the following commands: 
npm start 

 
OR 
 
yarn start 

4. Your default browser should show up with a basic react app running. 

5. Once that is done, you can stop the app by press Ctrl + C in the console. 
In the console type these commands to install the dependencies used in this project. 
npm install –-save react-router-dom semantic-ui-react 

6. In cf-react-frontend/src, create a subfolder called components and move App.js from the 
root into it. 

7. Once that is done, update your App.js with the following code: 
import React, { Component } from "react"; 
import NavigationBar from "./NavigationBar"; 
import Header from "./Header"; 
import Main from "./Main"; 
 
class App extends Component { 
  render() { 
    return ( 
      <div> 
        <Header /> 
        <NavigationBar /> 
        <Main /> 
      </div> 
    ); 
  } 
} 
 
export default App; 

Your main app is here and your main components will be thrown here. 

8. Create a file in the components folder called Main.js, and update with the following code: 
import React from "react"; 
import { Switch, Route } from "react-router-dom"; 
import Person from "./Person"; 
import PersonGroup from "./PersonGroup"; 
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import Face from "./Face"; 
import Train from "./Train"; 
import UploadedImages from "./UploadedImages"; 
 
const Main = () => { 
  return ( 
    <main> 
      <Switch> 
        <Route path="/(|person_group)" component={PersonGroup} /> 
        <Route path="/person" component={Person} /> 
        <Route path="/face" component={Face} /> 
        <Route path="/train" component={Train} /> 
        <Route path="/uploaded_images" component={UploadedImages}/> 
      </Switch> 
    </main> 
  ); 
}; 
 
export default Main; 

This will handle the main routing of the pages, and make the app into a single paged app, 
rather than loading url links. React-router is used in this. 

9. Create a file in components folder called NavigationBar.js and update with the following 
code: 
import React from "react"; 
import { Link } from "react-router-dom"; 
import { Menu } from "semantic-ui-react"; 
 
export default class NavigationBar extends React.Component { 
  constructor(props) { 
    super(props); 
 
    this.state = { 
      activeItem: "person_group" 
    }; 
  } 
 
  handleChange = (event, { name }) => { 
    this.setState({ 
      activeItem: name 
    }); 
  }; 
 
  render() { 
    return ( 
      <Menu pointing secondary> 
        <Link to="/"> 
          <Menu.Item name="person_group" onClick={this.handleChange}> 
            cf-react-frontend 
          </Menu.Item> 
        </Link> 
        <Link to="/person_group"> 
          <Menu.Item 
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            name="person_group" 
            active={this.state.activeItem === "person_group"} 
            onClick={this.handleChange} 
          > 
            Person group 
          </Menu.Item> 
        </Link> 
        <Link to="/person"> 
          <Menu.Item 
            name="person" 
            active={this.state.activeItem === "person"} 
            onClick={this.handleChange} 
          > 
            Person 
          </Menu.Item> 
        </Link> 
        <Link to="/train"> 
          <Menu.Item 
            name="train" 
            active={this.state.activeItem === "train"} 
            onClick={this.handleChange} 
          > 
            Train 
          </Menu.Item> 
        </Link> 
        <Link to="/face"> 
          <Menu.Item 
            name="face" 
            active={this.state.activeItem === "face"} 
            onClick={this.handleChange} 
          > 
          Scan face 
          </Menu.Item> 
        </Link> 
        <Link to="/uploaded_images"> 
          <Menu.Item 
            name="image" 
            active={this.state.activeItem === "image"} 
            onClick={this.handleChange} 
          > 
          History 
          </Menu.Item> 
        </Link> 
      </Menu> 
    ); 
  } 
} 

This will create a navigation bar that links using the Link component from react router 

10 Create a file in components folder called Header.js and update with the following code: 
import React from "react"; 
 
const Header = () => { 
  return ( 
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    <head> 
      <link 
        rel="stylesheet" 
        
href="https://maxcdn.bootstrapcdn.com/bootstrap/3.3.7/css/bootstrap.min.c
ss" 
        integrity="sha384-
BVYiiSIFeK1dGmJRAkycuHAHRg32OmUcww7on3RYdg4Va+PmSTsz/K68vbdEjh4u" 
        crossorigin="anonymous" 
      /> 
      <link 
        rel="stylesheet" 
        href="//cdnjs.cloudflare.com/ajax/libs/semantic-
ui/2.3.1/semantic.min.css" 
      /> 
    </head> 
  ); 
}; 
 
export default Header; 

This will call all the cdns for styling used by semantic-ui-react 

11. Create a file in components folder name PersonGroup.js and update with the following 
code: 
import React from "react"; 
import { 
  Grid, 
  Form, 
  Button, 
} from "semantic-ui-react"; 
 
export default class PersonGroup extends React.Component { 
  constructor(props) { 
    super(props); 
 
    this.state = { 
      person_group_list: [], 
      selectedGroup: "", 
      newGroupId: "", 
      newGroupName: "", 
      newGroupData: "" 
    }; 
 
    this.handleCreateSubmit = this.handleCreateSubmit.bind(this); 
  } 
 
  componentDidMount() { 
    fetch("http://127.0.0.1:5000/person_group_list") 
      .then(response => { 
        return response.json(); 
      }) 
      .then(data => { 
        let list = new Array(); 
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        data.forEach(obj => { 
          let text = obj.personGroupId; 
          list.push({ text: text, value: text }); 
        }); 
 
        this.setState({ 
          person_group_list: list 
        }); 
      }); 
  } 
 
  handleInputChange = event => { 
    const name = event.target.name; 
 
    this.setState({ 
      [name]: event.target.value 
    }); 
  }; 
 
  async handleCreateSubmit() { 
    const response = await fetch("http://127.0.0.1:5000/person_group", { 
      method: "PUT", 
      headers: { 
        "Content-Type": "application/json" 
      }, 
      body: JSON.stringify({ 
        person_group_id: this.state.newGroupId, 
        name: this.state.newGroupName, 
        user_data: this.state.newGroupData 
      }) 
    }); 
    const content = await response.json(); 
    if (content) { 
      alert("Created group"); 
    } 
  } 
 
  render() { 
    return ( 
      <Grid centered columns={2}> 
        <Grid.Column centered> 
          <Form onSubmit={this.handleCreateSubmit}> 
            <Form.Field> 
              <label>Person group id</label> 
              <input 
                name="newGroupId" 
                value={this.state.newGroupId} 
                onChange={this.handleInputChange} 
                placeholder="Group Id" 
              /> 
            </Form.Field> 
            <Form.Field> 
              <label>Group name</label> 
              <input 
                name="newGroupName" 
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                value={this.state.newGroupName} 
                onChange={this.handleInputChange} 
                placeholder="Group name" 
              /> 
            </Form.Field> 
            <Form.Field> 
              <label>Group data (Optional)</label> 
              <input 
                name="newGroupData" 
                value={this.state.newGroupData} 
                onChange={this.handleInputChange} 
                placeholder="Describe the group" 
              /> 
            </Form.Field> 
            <Button color="teal" type="submit"> 
              Create group 
            </Button> 
          </Form> 
        </Grid.Column> 
      </Grid> 
    ); 
  } 
} 

This will create a form to create a person group. 

12. Create a file in the components folder called Person.js and update with the following 
code: 
import React from "react"; 
import { 
  Grid, 
  Input, 
  Form, 
  Dropdown, 
  Button, 
  Divider 
} from "semantic-ui-react"; 
 
export default class Person extends React.Component { 
  constructor(props) { 
    super(props); 
 
    this.state = { 
      person_group_list: [], 
      person_group_id_create: "", 
      person_group_id_upload: "", 
      person_group_id_delete: "", 
      personName: "", 
      person_id_upload: "", 
      person_id_delete: "", 
      selectedFile: null, 
      person_list: [] 
    }; 
 
    this.fileUploadHandler = this.fileUploadHandler.bind(this); 
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    this.piCamUploadHandler = this.piCamUploadHandler.bind(this); 
    // this.multipleFileUploadHandler = 
this.multipleFileUploadHandler.bind(this); 
    this.createPersonHandler = this.createPersonHandler.bind(this); 
    this.deletePersonHandler = this.deletePersonHandler.bind(this); 
    this.uploadPersonGroupChangeHandler = 
this.uploadPersonGroupChangeHandler.bind( 
      this 
    ); 
    this.deletePersonGroupChangeHandler = 
this.deletePersonGroupChangeHandler.bind( 
      this 
    ); 
  } 
 
  componentDidMount() { 
    fetch("http://127.0.0.1:5000/person_group_list") 
      .then(response => { 
        return response.json(); 
      }) 
      .then(data => { 
        let list = new Array(); 
        data.forEach(obj => { 
          let text = obj.personGroupId; 
          list.push({ text: text, value: text }); 
        }); 
 
        this.setState({ 
          person_group_list: list 
        }); 
      }); 
  } 
 
  async deletePersonGroupChangeHandler(event, data) { 
    await this.setState({ person_group_id_delete: data.value }); 
 
    const response = await fetch( 
      "http://127.0.0.1:5000/person_list/" + 
this.state.person_group_id_delete 
    ); 
    response.json().then(responseData => { 
      let list = new Array(); 
      responseData.forEach(obj => { 
        let text = obj.name; 
        let value = obj.personId; 
        list.push({ text: text, value: value }); 
      }); 
      this.setState({ 
        person_list: list 
      }); 
    }); 
  } 
 
  async uploadPersonGroupChangeHandler(event, data) { 
    await this.setState({ person_group_id_upload: data.value }); 
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    const response = await fetch( 
      "http://127.0.0.1:5000/person_list/" + 
this.state.person_group_id_upload 
    ); 
    response.json().then(responseData => { 
      let list = new Array(); 
      responseData.forEach(obj => { 
        let text = obj.name; 
        let value = obj.personId; 
        list.push({ text: text, value: value }); 
      }); 
      this.setState({ 
        person_list: list 
      }); 
    }); 
  } 
 
  async createPersonHandler(event) { 
    const response = await fetch("http://127.0.0.1:5000/person", { 
      method: "PUT", 
      headers: { 
        "Content-Type": "application/json" 
      }, 
      body: JSON.stringify({ 
        person_group_id: this.state.person_group_id_create, 
        name: this.state.personName 
      }) 
    }); 
    const content = await response.json(); 
    if (content) { 
      alert("Created, your id is " + content.personId); 
    } 
  } 
 
  fileChangedHandler = event => { 
    this.setState({ 
      selectedFile: event.target.files[0], 
      selectedFileName: event.target.value 
    }); 
  }; 
 
  async fileUploadHandler() { 
    let formData = new FormData(); 
    formData.append("file", this.state.selectedFile); 
    formData.append("person_group_id", 
this.state.person_group_id_upload); 
    formData.append("person_id", this.state.person_id_upload); 
 
    const response = await fetch("http://127.0.0.1:5000/person", { 
      method: "POST", 
      body: formData 
    }); 
    const content = await response.json(); 
    alert(content); 
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  } 
 
  async piCamUploadHandler() { 
    let formData = new FormData(); 
    formData.append("person_group_id", 
this.state.person_group_id_upload); 
    formData.append("person_id", this.state.person_id_upload); 
 
    const response = await fetch("http://127.0.0.1:5000/person_pi", { 
      method: "POST", 
      body: formData 
    }); 
    const content = await response.json(); 
    alert(content); 
  } 
 
  // upload directory if theres time 
  // async multipleFileUploadHandler(event) { 
  //   let formData = new FormData(); 
 
  //   formData.append("files[]", this.state.selectedFile); 
  //   formData.append("person_group_id", 
this.state.person_group_id_upload); 
  //   formData.append("person_id", this.state.person_id_create); 
  // } 
 
  async deletePersonHandler(event) { 
    const response = await fetch("http://127.0.0.1:5000/person", { 
      method: "DELETE", 
      headers: { 
        "Content-Type": "application/json" 
      }, 
      body: JSON.stringify({ 
        person_group_id: this.state.person_group_id_delete, 
        person_id: this.state.person_id_delete 
      }) 
    }); 
    const content = await response.json(); 
    return content; 
  } 
 
  render() { 
    return ( 
      <Grid centered columns={2}> 
        <Grid.Column centered> 
          <Form> 
            <label>Create person</label> 
            <Form.Field> 
              <Dropdown 
                placeholder="Select person group" 
                search 
                selection 
                fluid 
                options={this.state.person_group_list} 
                value={this.state.person_group_id_create} 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 108 of 125  
 

  
  

                onChange={(event, data) => { 
                  this.setState({ 
                    person_group_id_create: data.value 
                  }); 
                }} 
              /> 
            </Form.Field> 
            <Form.Field> 
              <Input 
                label="Create person name" 
                type="text" 
                fluid 
                value={this.state.personName} 
                onChange={event => { 
                  this.setState({ personName: event.target.value }); 
                }} 
                action={{ 
                  content: "Create", 
                  color: "teal", 
                  onClick: this.createPersonHandler 
                }} 
              /> 
            </Form.Field> 
          </Form> 
          <Divider /> 
          <Form> 
            <label>Select person for upload</label> 
            <Form.Field> 
              <Dropdown 
                placeholder="Select person group" 
                search 
                selection 
                fluid 
                options={this.state.person_group_list} 
                value={this.state.person_group_id_upload} 
                onChange={this.uploadPersonGroupChangeHandler} 
              /> 
            </Form.Field> 
            <Form.Field> 
              <Dropdown 
                placeholder="Select person for upload" 
                search 
                selection 
                fluid 
                options={this.state.person_list} 
                value={this.state.person_id_upload} 
                onChange={(event, data) => { 
                  this.setState({ person_id_upload: data.value }); 
                }} 
              /> 
            </Form.Field> 
            <Form.Field> 
              <Input 
                label="Upload photo" 
                type="file" 
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                fluid 
                onChange={this.fileChangedHandler} 
                action={{ 
                  content: "Upload", 
                  color: "teal", 
                  onClick: this.fileUploadHandler 
                }} 
              /> 
            </Form.Field> 
            <Form.Field> 
              <label>Click this take photo using picam and upload</label> 
              <Button onClick={this.piCamUploadHandler} color="teal"> 
                TAKE PHOTO 
              </Button> 
            </Form.Field> 
            {/* Will do upload directory if there's time */} 
            {/* <Form.Field> 
              <input 
                label="Upload directory" 
                type="file" 
                fluid 
                webkitdirectory 
                directory 
                multiple 
                onChange={this.fileChangedHandler} 
                action={{ 
                  content: "Upload", 
                  color: "teal", 
                  onClick: this.multipleFileUploadHandler 
                }} 
              /> 
            </Form.Field> */} 
          </Form> 
          <Divider /> 
          <Form> 
            <label>Delete person</label> 
            <Form.Field> 
              <Dropdown 
                placeholder="Select person group" 
                search 
                selection 
                fluid 
                options={this.state.person_group_list} 
                value={this.state.person_group_id_delete} 
                onChange={this.deletePersonGroupChangeHandler} 
              /> 
            </Form.Field> 
            <Form.Field> 
              <label>Select person for delete</label> 
              <Dropdown 
                placeholder="Select person for delete" 
                search 
                selection 
                fluid 
                options={this.state.person_list} 
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                value={this.state.person_id_delete} 
                onChange={(event, data) => { 
                  this.setState({ person_id_delete: data.value }); 
                }} 
              /> 
            </Form.Field> 
            <Button color="red" onClick={this.deletePersonHandler}> 
              Delete person 
            </Button> 
          </Form> 
        </Grid.Column> 
      </Grid> 
    ); 
  } 
} 

This page consist of the CRUD of a person. Also where you can upload images for a person. 

13. Create a file in components folder called Train.js and update with the following code: 
import React from "react"; 
import { Button, Grid, Form, Dropdown } from "semantic-ui-react"; 
 
export default class Train extends React.Component { 
  constructor(props) { 
    super(props); 
 
    this.state = { 
      person_group_list: [], 
      person_group_id: "" 
    }; 
 
    this.onClickTrain = this.onClickTrain.bind(this); 
    this.onClickStatus = this.onClickStatus.bind(this); 
    this.onClickDelete = this.onClickDelete.bind(this); 
  } 
 
  componentDidMount() { 
    fetch("http://127.0.0.1:5000/person_group_list") 
      .then(response => { 
        return response.json(); 
      }) 
      .then(data => { 
        let list = new Array(); 
        data.forEach(obj => { 
          let text = obj.personGroupId; 
          list.push({ text: text, value: text }); 
        }); 
 
        this.setState({ 
          person_group_list: list 
        }); 
      }); 
  } 
 
  async onClickTrain() { 



Sofia, Elvis, Jeremy ST0324 Internet of Things CA2 Step-by-step Tutorial 
 

Created by Dora Page 111 of 125  
 

  
  

    const response = await fetch("http://127.0.0.1:5000/person_group", { 
      method: "POST", 
      headers: { 
        "Content-Type": "application/json" 
      }, 
      body: JSON.stringify({ 
        person_group_id: this.state.selectedGroup 
      }) 
    }); 
    const content = await response.json(); 
    if (content) { 
      alert(content.status); 
    } 
  } 
 
  async onClickStatus() { 
    const response = await fetch("http://127.0.0.1:5000/status", { 
      method: "POST", 
      headers: { 
        "Content-Type": "application/json" 
      }, 
      body: JSON.stringify({ 
        person_group_id: this.state.selectedGroup 
      }) 
    }); 
    const content = await response.json(); 
    alert("Data training is " + content.status); 
  } 
 
  async onClickDelete() { 
    const reposne = await fetch("http://127.0.0.1:5000/status", { 
      method: "DELETE", 
      headers: { 
        "Content-Type": "application/json" 
      }, 
      body: JSON.stringify({ 
        person_group_id: this.state.selectedGroup 
      }) 
    }); 
  } 
 
  render() { 
    return ( 
      <Grid centered columns={2}> 
        <Grid.Column centered> 
          <Form> 
            <label>Select person group</label> 
            <Form.Field> 
              <Dropdown 
                placeholder="Select person group" 
                search 
                selection 
                name="selectedPerson" 
                options={this.state.person_group_list} 
                value={this.state.selectedGroup} 
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                onChange={(event, data) => { 
                  this.setState({ 
                    selectedGroup: data.value 
                  }); 
                }} 
              /> 
            </Form.Field> 
            <Button onClick={this.onClickTrain} color="teal"> 
              Train 
            </Button> 
            <Button onClick={this.onClickStatus} color="green"> 
              Status 
            </Button> 
            <Button onClick={this.onClickDelete} color="red"> 
              Delete 
            </Button> 
          </Form> 
        </Grid.Column> 
      </Grid> 
    ); 
  } 
} 

This will create the component to call the cognitive services to train your images, you can 
also check the status of the training, and delete a person group here. 

14. Create a file in components folder called Face.js and update with the following code: 
import React from "react"; 
import { Button, Grid, Form, Dropdown, Divider } from "semantic-ui-
react"; 
import EditText from "./EditText"; 
 
const RenderImage = props => { 
  if (!props.show) { 
    return null; 
  } 
  return <img src={props.url} />; 
}; 
 
export default class Face extends React.Component { 
  constructor(props) { 
    super(props); 
 
    this.state = { 
      person_group_list: [], 
      person_group_id: "", 
      showImage: false, 
      imageUrl: "" 
    }; 
 
    this.onClickHandler = this.onClickHandler.bind(this); 
  } 
 
  componentDidMount() { 
    fetch("http://127.0.0.1:5000/person_group_list") 
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      .then(response => { 
        return response.json(); 
      }) 
      .then(data => { 
        let list = new Array(); 
        data.forEach(obj => { 
          let text = obj.personGroupId; 
          list.push({ text: text, value: text }); 
        }); 
 
        this.setState({ 
          person_group_list: list 
        }); 
      }); 
  } 
 
  async onClickHandler() { 
    const response = await fetch("http://127.0.0.1:5000/face", { 
      method: "POST", 
      headers: { 
        "Content-Type": "application/json" 
      }, 
      body: JSON.stringify({ 
        person_group_id: this.state.person_group_id 
      }) 
    }); 
 
    const content = await response.json(); 
    console.log(content); 
    if (content) { 
      alert("Picture taken, you are: " + content.name); 
      this.setState({ 
        imageUrl: content.imageUrl, 
        showImage: true 
      }); 
    } 
    alert("Something went wrong"); 
  } 
 
  render() { 
    return ( 
      <Grid centered columns={2}> 
        <Grid.Column> 
          <Form> 
            <Form.Field> 
              <label>Select person group</label> 
              <Dropdown 
                placeholder="Select person group" 
                search 
                selection 
                fluid 
                options={this.state.person_group_list} 
                value={this.state.person_group_id} 
                onChange={(event, data) => { 
                  this.setState({ 
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                    person_group_id: data.value 
                  }); 
                }} 
              /> 
            </Form.Field> 
            <Form.Field> 
              <Button color="teal" onClick={this.onClickHandler}> 
                TAKE PHOTO 
              </Button> 
            </Form.Field> 
          </Form> 
          <Divider/> 
          <Form> 
            <Form.Field> 
              <label>Edit the lcd</label> 
              <EditText/> 
            </Form.Field> 
          </Form> 
          <RenderImage show={this.state.showImage} 
url={this.state.imageUrl} /> 
        </Grid.Column> 
      </Grid> 
    ); 
  } 
} 

This page allows you to take a photo using the picamera, and also edit the lcd text. 

15. Create a file in components folder called EditText.js and update with the following code: 
import React from "react"; 
import { Input } from "semantic-ui-react"; 
 
export default class EditText extends React.Component { 
  constructor(props) { 
    super(props); 
 
    this.state = { 
      text: "" 
    }; 
 
    this.handleInputChange = this.handleInputChange.bind(this); 
  } 
 
  async handleInputChange(event) { 
    await this.setState({ 
      text: event.target.value 
    }); 
 
    let formData = new FormData(); 
    formData.append("text", this.state.text); 
 
    const response = await fetch("http://127.0.0.1:5000/lcd", { 
        method: "POST", 
        body: formData 
    }); 
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  } 
 
  render() { 
    return <Input value={this.state.text} 
onChange={this.handleInputChange} />; 
  } 
} 

This is a component that I split out to make things clear which is imported and used in 
Face.js. By right we should be spliting the components so that we can reuse them if 
needed and it will keep the project cleaner and easier to maintain. 

16. Create a file in components folder called UploadedImages.js and update with the 
following code: 
import React from "react"; 
import { Image, Grid } from "semantic-ui-react"; 
 
export default class UploadedImages extends React.Component { 
  constructor(props) { 
    super(props); 
 
    this.state = { 
      imageUrls: [] 
    }; 
  } 
 
  componentDidMount() { 
    fetch("http://127.0.0.1:5000/all_image") 
      .then(response => { 
        return response.json(); 
      }) 
      .then(data => { 
        console.log(data); 
        this.setState({ 
          imageUrls: data 
        }); 
      }); 
  } 
 
  render() { 
    let urls = this.state.imageUrls; 
 
    let images = urls.map(url => { 
      return ( 
        <Grid.Column> 
          <Image src={url} /> 
        </Grid.Column> 
      ); 
    }); 
 
    return <Grid columns={5}>{images}</Grid>; 
  } 
} 
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This will call fetch get calls into the backend to call from cloudinary the images that you’ve 
uploaded. 

17. Now head to your console and start the app again. Your frontend setup is finished! 

 
 
 

-- End of CA2 Step-by-step tutorial -- 
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